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1. Introduction 
 
Clinical Procedures (CP) is a new VistA package that provides features that can be used across 
clinical departments, such as general medicine, cardiology, pulmonary, women’s health, 
neurology, and rehabilitation medicine. CP is a conduit for passing patient results, using HL7 
messaging, between the vendor and VistA. Patient test results are displayed in the Computerized 
Patient Record System (CPRS). CP includes three modules, which are CP User, CP Manager, 
and CP Gateway. 
 
CP User is the primary application that clinicians use. For example, you can place an order for a 
procedure, such as an EKG, through the Consults tab or Orders tab in CPRS, or Order Entry. 
Then you can use CP User to check in a patient and initiate the actual procedure. If the procedure 
is performed on a bi-directional instrument, the patient demographics are automatically 
transmitted to the instrument. When the procedure is complete, the result is transmitted back to 
VistA Imaging and attached to a TIU note/document that is associated with the original 
procedure order. 
 
If the procedure is performed on a uni-directional instrument, you use CP User to match the 
instrument results to the requested procedure. The TIU note is created when the instrument 
results are submitted to VistA Imaging. Standard Consults functionality is used to complete and 
sign the TIU note. The main purpose of CP User is to link the results from the automated 
instrument to the procedure ordered through Consults in CPRS. 
 
System managers and clinical application coordinators use CP Manager. The main purpose of 
this application is to add and edit automated instruments and procedures in the CP database. CP 
Manager is also used to configure the site files and required system parameters.   
 
CP Gateway manages the flow of information from the instrument interfaces to CPRS. CP 
Gateway polls the system regularly for new data from instruments and processes this data into 
usable attachments for the VistA Imaging system.   
 
Topics discussed in this chapter are: 
 

 Intended Audience 
 Related Manuals 
 Product Benefits 

 
The following pages contain flowcharts explaining the bi-directional and uni-directional Clinical 
Procedures process flow. 
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Clinical Procedures Bi-Directional Interface Process Flow: 
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Clinical Procedures Uni-Directional Interface Process Flow: 
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Intended Audience 
 
This User Manual is intended for use by clinicians, physicians, nurses, technicians, TSO, and 
IRMS. End users should be familiar with the following: 
 

 Windows operating systems 
 CPRS functionality 

 
 

Related Manuals 
 
Here is a list of related manuals that you may find helpful: 
 

Clinical Procedures Installation Guide 
Clinical Procedures Technical Manual and Package Security Guide 
Clinical Procedures Implementation Guide 
Clinical Procedures Release Notes 
CPRS User Manual 
Consult/Request Tracking User Manual 
Consult/Request Tracking Technical Manual 
Text Integration Utilities (TIU) Implementation Guide 
Text Integration Utilities (TIU) User Manual 
VistA Imaging System (Clinical) User Manual 

 
You can locate these manuals in the VistA Documentation Library (VDL). Select Clinical from 
the VDL web page, select the package you want, and then select the manuals. For example, you 
can select CPRS on the left side of the page. The list of CPRS manuals is displayed.  
 
 

Product Benefits 
 

 Common User Interface 
Clinicians can use CPRS to enter, review, interpret, and sign CP orders. CP documents in 
TIU obey Authorization Subscription Utility (ASU) Business Rules. The update users 
functionality currently used by Consults determines which users are allowed to access or 
edit CP documents.   
 
 Integration 
Clinicians order procedures in CPRS. Orders are processed through the Consult/Request 
Tracking Package (Consults) and data is interpreted, entered, and displayed through 
CPRS. Final results of the CP procedure are displayed by VistA Imaging. Ordering, 
viewing, reviewing, interpreting, and signing the CP medical record is accessed through 
one location, the CPRS Consults tab. You use CP User to check in patients. CP User also 
links the result from the automated instrument to the procedure ordered through Consults.  
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 Variety of Accepted File Types 
CP is able to accept data/final result report files from automated instruments. The 
supported imaging file types are the following: 
 
 .txt  Text files 
 .rtf Rich text files 
 .jpg JPEG Images 
 .jpeg JPEG Images 
 .bmp Bitmap Images 
 .tiff TIFF Graphics (group 3 and group 4 compressed and uncompressed types)  
 .pdf Portable Document Format 
 .html Hypertext Markup Language  
 
.DOC (Microsoft Word files) are not supported. Be sure to convert .doc files to .rtf or to 
.pdf format. 
 
 Links to Other Packages 
CP interfaces with packages such as Computerized Patient Record System (CPRS), 
Consult/Request Tracking package, Text Integration Utility package (TIU), and VistA 
Imaging.  
 
 Interface Between CP and Imaging 
Certain images such as consent forms and report objects are acquired, processed, stored, 
transmitted, and displayed by the VistA Imaging package. This interface between CP and 
Imaging replaces the existing capture interface between Medicine 2.3 and VistA Imaging. 
 
 Inpatient and Outpatient Workloads 
The Hospital Location, where the procedure is performed, is defined in the CP Definition 
file (#702.01). The hospital location determines which Encounter Form is presented to 
the end user. CPRS and TIU parameters allow for the configuration of TIU software to 
display the electronic encounter form and prompt users to enter workload data. The data 
is then passed to the Patient Care Encounter software (PCE) for inpatients and 
outpatients.   
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2. Working with CP User 
 
This chapter describes how to get started with CP User. 
 
Topics discussed in this chapter are: 
 

 Opening CP User 
 Defining CP User Icons 
 Selecting a Patient 
 Defining the Parts of the Main CP User Window 

 
 

Opening CP User 
 
With CP User, the result from the automated medical device is linked to the procedure that was 
ordered through the Consults tab.   
 

 Double-click CP User on your desktop. If you are not currently logged into the VistA 
system, you need to enter your access and verify codes. Click OK. The main CP User 
window is displayed. 

 
 

Defining CP User Icons 
 
 Select View > Use Toolbar.  
 

  Open Patient – Opens a new patient record. 
 

  Refresh Patient - Refreshes the currently selected patient’s information. 
 

  Check-in New Study - Checks-in a patient and opens a new study. 
 

  Open Study - Opens a currently selected study. 
 

  Delete Study - Deletes a currently selected study. 
 

  Help - Provides on-line help for this package. 
 

  Clinical Procedures Home Page - Goes to the Clinical Procedures Home Page on the Web. 
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Selecting a Patient 
 

1. Open CP User.  
 

2. Select File > Open Patient. The main CP User screen lets you select a patient that has a 
consult procedure ordered. You can choose Patient, Team, Clinic, or Ward. 

 
- Choose Patient if you want to select a patient by name, complete SSN, or first initial 

of the last name and the last four digits of the SSN. 
- Choose Team if you want to select a patient from a specific team list defined in the 

OE/RR List file (#100.21). 
- Choose Clinic if you want to select a patient from selected clinic appointments for a 

predetermined clinic and date. 
- Choose Ward if you want to select a patient from selected MAS wards.  

 

 
Figure 2-1 

 
3. Double-click the patient’s name. A confirmation screen is displayed, which shows 

additional information about the selected patient. See Figure 2-1. If you select a sensitive 
patient, a sensitive patient window is displayed indicating that the patient’s information 
should only be accessed on a need to know basis.  

 
4. Click OK. Figure 2-2, the main CP User window is displayed. 
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Defining the Parts of the Main CP User Window 
 
In this main window, you can select a treating specialty from the left and view a list of 
procedures within that treating specialty on the right. Click the column headers to sort them in 
ascending or descending order.  
 

 
Figure 2-2 

 
The status column displays New, Submitted, Error, Ready to Complete, Pending Instrument 
Data, and Complete. Here is a description of each status type in Figure 2-2. 
 

 New - (The New status is only available with VistA Imaging.) A study has been 
requested by VistA Imaging and needs to be checked-in and submitted to an 
instrument. Example: You scanned in a consent form through the VistA Imaging 
Capture Workstation. A new CP Study record is created along with a TIU document.  
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 Submitted - This study has been submitted to the VistA Imaging Background 

Processor. The study report waits in the Imaging Background Processor queue to be 
copied or processed and placed on the VistA Imaging server. A study in this status is 
not accessible until VistA Imaging returns a status of Complete or Error and logs any 
errors encountered in the submission process. 

 
 Error - This study has encountered an error while being submitted to VistA Imaging. 

The error may have been caused when the TIU note was created, when a visit was 
created, when the results were linked to the procedure, or when the attachments were 
sent to the VistA Imaging server. Error messages are logged with the study and can 
be reviewed by opening the study in an error status.  

 
 Complete - This study has successfully created a TIU note for interpretation and 

images have been sent to VistA Imaging for the selected consult procedure order. If 
any attachments were included, they have been successfully copied to the VistA 
Imaging server.  

 
 Pending Instrument Data – (This status is only valid for bi-directional instruments 

that have not returned results.) The procedure request has been submitted to a bi-
directional instrument and is waiting for the instrument to return the results. Studies 
in this status should not be opened until the instrument has returned the results, 
assigned them to the study, and marked the study as Ready to Complete.  
 
- If the “Auto Submit to VistA Imaging” checkbox is selected for the associated 
procedure in CP Manager, the study goes to Complete. 
- If the “Auto Submit to VistA Imaging” checkbox is not selected for the associated 
procedure in CP Manager, the study goes to Ready to Complete. 
 

 Ready to Complete –  
When a study is done on a uni-directional instrument, the status displays as Ready to 
Complete.  
 
When a study is submitted to a bi-directional instrument, the study remains in 
Pending Instrument Data status and changes to Ready to Complete after the study has 
received the data from the instrument. (Auto Submit to VistA Imaging is not 
selected.) 
 
In the Ready to Complete status, you can open the study, view the Consult/Procedure 
order, and manually submit instrument results and external attachments to VistA 
Imaging. 
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A study can be deleted when it has a status of “Pending Instrument Data” and the user has the 
MD Manager key. A study should be deleted only if the study was sent to the wrong instrument, 
or if the patient was unable to complete the procedure. Select File > Delete Study and click 
Delete. A cancel order is sent to the device. If that device is not working, you must manually 
delete the order from the device. Refer to the manual for your specific instrument for instructions 
on deleting an order. 
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3. Clinical Procedures Process, Part 1 
 
This chapter describes the process to follow for ordering clinical procedures. (Although you can 
order several types of procedures in CPRS, you must follow the steps in this chapter to order 
clinical procedures.) This chapter uses the example of ordering a colonoscopy test to describe the 
Clinical Procedures ordering process. Be sure to follow the required steps in sequential order. 
You can do the optional steps as needed. 
 

1. Order a consult procedure in CPRS. Required 
2. Check in a new study. Required 
3. Update study status to correct errors. Optional 
 

 

Ordering a Consult Procedure in CPRS  
 
This section describes how to order a CP procedure, such as a study, a test, or an invasive 
intervention, such as a surgical or medical procedure, through CPRS. Keep in mind that you can 
only order a Clinical Procedure as a procedure order and not as a consult request.  
 
In addition to becoming familiar with the CPRS ordering process, you can learn about the 
interpreter, which is the new user role within ASU that supports CP. The interpreter is a new 
User Role created by ASU that defines a user who can interpret (sign-off or verify) the 
procedure’s final report. Clinical application coordinators define interpreters in the Consults 
package.   
 
If you are an interpreter for a specific procedure, you can receive an alert when the procedure 
results are ready for review. Additional comments can be added if necessary along with the 
Procedure Summary code and the electronic signature. The following example describes how to 
order a colonoscopy procedure through the CPRS Consults tab.   
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1. Logon to CPRS. The Patient Selection window is displayed, Figure 3-1. 

 

 
Figure 3-1 

 
2. Select a patient. Notice that CPPATIENT, ONE is the selected patient. The Cover Sheet 

window is displayed, Figure 3-2. 
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Figure 3-2 

 
3. Click the Consults tab at the bottom of the window, Figure 3-3.  
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Figure 3-3 

 
4. If you want to review an existing Consult or procedure, select one in the list from the 

upper left panel. The lower left panel contains any supporting documents for the selected 
consult or procedure, and the larger right panel contains the order details. 

 
5. Click New Procedure on the left side of the Consults tab. You can also order a clinical 

procedure from the Orders tab. Since CPPATIENT, ONE is an inpatient, the Order a 
Procedure window, Figure 3-5, is displayed. Go to step 7 to order the procedure. 

 
(If you were to select an outpatient, Figure 3-4 appears so you can enter a location. Go to 
step 6.) 
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Figure 3-4 

 
6. For Outpatients, select either the Clinic Appointments or New Visit tab.  

- Select Clinic Appointments if the patient already has an appointment through 
Scheduling.  
- Select New Visit if an appointment has not been made through Scheduling, and then 
select a location from the list of Visit Locations. The Encounter Location is filled in 
automatically. 
- If the patient had existing admissions, these are displayed under the Hospital 
Admissions tab.  
- Go to step 7 to order the procedure. 
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Figure 3-5 

 
7. To order the colonoscopy procedure, select Colonoscopy from the Procedure dropdown 

list, Figure 3-5.  
 
- Complete the appropriate fields.  
- Click Accept Order.  
- Click Quit.  

 
8. To sign the consult procedures, select File > Review/Sign Changes. Figure 3-6 is 

displayed. 
 
- Click the appropriate check box to select the colonoscopy.  
- Enter your electronic signature code.  
- Click Sign to return to the Consults tab. At this point, the procedure order is completed. 
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Figure 3-6 

 
9. Click the Orders tab to review the ordered procedures. These procedure orders appear 

on the Active Orders sheet (Figure 3-7). 
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Figure 3-7 
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1Auto Study Check-In 
 
The auto study check in is a new enhancement introduced with patch MD*1.0*14. The site can 
specify a procedure to have auto study check in using the MD AUTO CHECK-IN SETUP 
option. Refer to the Clinical procedures Implementation Guide to set up a procedure for the auto 
study check-in. This new functionality can be used if the site schedules an appointment for the 
patient or not. If the site does not use appointments, the study will be checked in as soon as the 
order is requested in CPRS. The status of the study will be “Pending Instrument Data”. If the site 
uses appointments, the study will have a status of “New” until the day of the appointment and the 
status will change to “Pending Instrument Data”. 
 
For procedures that require multiple encounters from the patient such as hemodialysis, 
respiratory therapy, and sleep studies, each encounter will generate a study check-in if there is an 
appointment scheduled for each encounter. If no appointment is used, only the initial check-in 
will be auto checked-in and the additional encounters will still require manual check-in. 
 
Once a procedure is set up to use the auto study check-in functionality in the MD CHECK-IN 
SETUP option, the software will check-in any existing order requests with the status of 
“PENDING”, “ACTIVE”, and “SCHEDULED” in the Consult Request Tracking package. 
 
If you have set up a procedure for auto check-in, you can skip the section on Check in a new 
study. The study will be checked-in for you when the order is requested in CPRS. 
 
Note 1: If the patient is a no show, you must remove the study that was checked-in. You can 
delete the check-in in CP User or you can cancel the procedure in CPRS. If you cancel or 
discontinue the order in CPRS, the status of the CP study will be changed to “Cancelled”. If the 
appointment is rescheduled, the study will still need to be removed. 
 
Note 2: Please make sure the studies are completed on time. If a previous study is still in 
“Pending Instrument Data” or “Ready to Complete” status, the subsequent study check-in for the 
subsequent encounter will not be effective until the previous study is complete. 
 
Note 3: In the case of an emergency procedure, the procedure will be performed prior to the 
order request. The order request will be entered after the procedure and the study will be auto 
checked in. You will need to attach the result manually as a uni-directional interface and submit 
the result. Since the study is auto checked-in for the bi-directional device, you will need to clean 
up and remove the patient name from the selection list on the device. 
 
In order to set up a procedure for auto-check-in, make sure you already have the procedure set up 
in Clinical Procedures and Consults/Request Tracking. If your site is just implementing Clinical 
Procedures for the first time, set up the procedure and instrument for the regular Clinical 
Procedure interface before implementing the procedure for auto study check-in. 

                                                 
1 Patch MD*1.0*14  March 2008  Added new section for Auto Study Check in. 
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Auto Check-In Without Appointment 
 
Once a procedure is set up to use the auto study check-in functionality, the software will check-
in any existing order requests with the status of “PENDING,” “ACTIVE,” and “SCHEDULED” 
in the Consult Request Tracking package. 
 
In this section, the following workflows are described: 

 Setting Up the Procedure for auto study check-in. 
 Procedure Request in CPRS. 
 Confirming the auto study check-in 

 
Setting Up the Procedure 
Use the option MD AUTO CHECK-IN SETUP to indicate which procedure will use the auto 
check-in functionality. 
 
Note: If your site uses appointments, schedule them before you enter the procedures for auto 
check-in. If you do not, the patients associated with those appointments will need to be manually 
checked in. 
 
This option collects the following information: 
 

1) Use Appointment with procedure? (Yes/No) (Required) – The default is “NO” if 
the site does not schedule procedures before the order is entered. Enter “YES” if 
the procedure appointment is scheduled before the order is entered and the 
ordering provider selects the appointment for the procedure during ordering in 
CPRS. Take the default of “NO” if the provider sometimes selects the 
appointment scheduled and sometime doesn’t. This prompt only applies to 
outpatients. 

2) Procedure (Required) – Enter the CP Definition that will be using the auto study 
check-in functionality. 

3) Schedule Appointment? (Required) – Enter 0 for None, 1 for Outpatient, 2 for 
Inpatient, or 3 for Both. This indicates that the site schedules appointments for 
inpatient, outpatients, both, or none. 

4) Clinic (Optional) – Enter the hospital location(s) that will be used for the 
scheduled procedure. You can enter more than one location for a procedure. After 
you have entered one hospital location, you will be asked if you want to enter 
another. 

 
NOTE: If no clinic is entered in the setup, CP will use the hospital location 
defined in the HOSPITAL LOCATION field of the CP Definition file (#702.01) 
as the location of the visit for the CP study check-in. 
 

In the following example, an EKG Routine (12 Leads) procedure is set up for auto study check-
in. 
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Select OPTION NAME: MD AUTO CHECK-IN SETUP       Auto Study Check-In Setup 
Auto Study Check-In Setup 
Use Appointment with procedure? NO// ? 
 
Default should be 'N' as most sites do not schedule procedures 
before the order is entered.  Select 'Y' if the procedure appointment 
is scheduled before the order is entered and the ordering provider 
selects the appointment for the procedure. 
Enter either 'Y' or 'N'. 
 
Use Appointment with procedure? NO// 
Procedure: ? 
Enter a CP Definition for the procedure to 
have auto CP study check-in. 
 
 Answer with CP DEFINITION NAME 
 Do you want the entire CP DEFINITION List? y  (Yes) 
   Choose from: 
   COL BIOPSY         
   COLONOSCOPY         
   EKG, ROUTINE (12 LEADS)         
   HEMODIALYSIS, REPEATED EVAL.         
   PULMONARY PROCEDURES         
     
 
Procedure: EKG, ROUTINE (12 LEADS) 
Schedule Appointment?: ? 
 
 
REQUIRED field for the procedure to have auto CP study check-in. 
Enter a "^" will exit completely. 
 
Enter 0 if you do not schedule appointments. 
      1 if you only schedule appointments for outpatients. 
      2 if you only schedule appointments for inpatients. 
      3 if you schedule appointments for both 1 and 2. 
 
     Select one of the following: 
 
          0         None 
          1         Outpatient 
          2         Inpatient 
          3         Both 
 
Schedule Appointment?: 0  None 
 
Procedure: 

 
In the example shown above, the EKG Routine (12 Leads) is set up for auto check-in without an 
appointment involved. The default of “NO” was entered for the question “Use Appointment with 
procedure?” and 0 was entered for the question “Schedule Appointment?” 
 
Use CPManager.exe and verify for the EKG procedure that you have 1) the hospital location 
field filled in, 2) the Active checkbox is checked, and 3) One bi-directional instrument checkbox 
is checked. 
 



Clinical Procedures Process, Part 1 

3-12 Clinical Procedures V. 1.0 April 2004 
 User Manual 

 
Figure 3-8 

 
Use CP Manager.exe and verify that the Muse EKG instrument is set up. Use the Interface 
Analyzer button, check the instrument Muse EKG, and click Analyze. The Ready Status should 
be “Pass.” 
 
Note:  Make sure the instrument is Active, has a Notification Mailgroup, and HL7 link. 
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Figure 3-9 

 

 
Figure 3-10 
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Figure 3-11 

 
Use the GMRC PROCEDURE SETUP to verify that EKG, ROUTINE (12 LEADS) is linked to 
a GMRC Procedure in Consult. 
 
Select OPTION NAME: GMRC PROCEDURE SETUP       Setup procedures 
Setup procedures 
Select Procedure:CP EKG 
     1   CP EKG 12 LEAD STAT   
     2   CP EKG INPATIENT,48 HRS, CONS CHOICE   
     3   CP EKG INPATIENT,STAT   
CHOOSE 1-5: 1  EKG 12 LEAD STAT 
NAME: CP EKG 12 LEAD STAT//  
INACTIVE: NO//  
Select SYNONYM: EKG//  
INTERNAL NAME:  
Select RELATED SERVICES: CARDIOLOGY CLINIC//  
TYPE OF PROCEDURE:  
CLINICAL PROCEDURE: EKG, ROUTINE (12 LEADS)        
  
PREREQUISITE: 
  1> 
PROVISIONAL DX PROMPT:  
PROVISIONAL DX INPUT:  
DEFAULT REASON FOR REQUEST: 
  1> 
RESTRICT DEFAULT REASON EDIT:  
 
Orderable Item Updated 
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Procedure Request in CPRS 
 
The procedure request is ordered and signed as you would for any other procedure in CPRS. 
 

 
Figure 3-12 
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Figure 3-13 
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Confirm the Auto Study Check-In 
 
Once the procedure is requested and signed in CPRS, the study for the EKG procedure will be 
auto checked-in in CPUSER with the status of “Pending Instrument Data”. 
 

 
Figure 3-14 

 

Auto Study Check-In With Appointment 
 
If your site scheduled an appointment for the procedure, the study will be checked in and the 
study will not take into effect until the day of the appointment. 
 
In this section, we will follow an example workflow of the auto study check-in for a procedure 
with appointment involved. In the next example, the Pulmonary Procedure is used to show the 
setup of the procedure for auto check-in and both inpatient and outpatient have an appointment 
scheduled. 
 
A new visit is not an appointment scheduled. If your site only creates a new visit for the patient 
upon order request, it would not be considered an appointment scheduled. 
 
Select OPTION NAME: MD AUTO CHECK-IN SETUP       Auto Study Check-In Setup 
Auto Study Check-In Setup 
Use Appointment with procedure? NO// ? 
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Default should be 'N' as most sites do not schedule procedures 
before the order is entered.  Select 'Y' if the procedure appointment 
is scheduled before the order is entered and the ordering provider 
selects the appointment for the procedure. 
Enter either 'Y' or 'N'. 
                         
Use Appointment with procedure? NO// 
 
Procedure                  Schedule Appt.              Clinic 
---------                  --------------              ------ 
EKG, ROUTINE (12 LEADS)    None                        None 
                                  
Procedure: ? 
Enter a CP Definition for the procedure to 
have auto CP study check-in. 
                     
 Answer with CP DEFINITION NAME 
 Do you want the entire CP DEFINITION List? y  (Yes) 
   Choose from: 
   COL BIOPSY         
   COLONOSCOPY         
   EKG, ROUTINE (12 LEADS)         
   HEMODIALYSIS, REPEATED EVAL.         
   PULMONARY PROCEDURES         
 
Procedure: PULMONARY PROCEDURES        
Schedule Appointment?: ? 
                         
REQUIRED field for the procedure to have auto CP study check-in. 
Enter a "^" will exit completely. 
 
Enter 0 if you do not schedule appointments. 
      1 if you only schedule appointments for outpatients. 
      2 if you only schedule appointments for inpatients. 
      3 if you schedule appointments for both 1 and 2. 
 
     Select one of the following: 
 
          0         None 
          1         Outpatient 
          2         Inpatient 
          3         Both 
 
Schedule Appointment?: 3  Both 
 
Clinic: ? 
Only required, if appointments are scheduled for the procedure. 
Enter the clinic used for scheduling the procedure. 
 
 Answer with HOSPITAL LOCATION NAME, or ABBREVIATION, or TEAM 
 Do you want the entire 112-Entry HOSPITAL LOCATION List? N 
 
Clinic: PFT LAB 
        
Enter another clinic for the same procedure? NO// ? 
                                               
Enter either 'Y' or 'N', if you want to assign more than one clinic. 
                                                
Enter another clinic for the same procedure? NO// YES 
Clinic: SHIR 
     1   SHIRL CLINIC        
     2   SHIRL-2        
CHOOSE 1-2: 2  SHIRL-2     
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Enter another clinic for the same procedure? NO//  
                                          
Procedure: 
 

Use CPManager.exe and verify for the PULMONARY PROCEDURE that you have 1) left the 
hospital location field blank, 2) checked the Active checkbox, and 3) checked One Bi-directional 
instrument checkbox. 
 
Note: The Hospital Location field is blank because the location of the appointment will be used 
for workload. 
 

 
Figure 3-15 

 

Use CP Manager.exe and verify that the SMC instrument is set up. Use the Interface Analyzer 
button and check the instrument SMC and click Analyze. The Ready Status should be “Pass.” 
 
Note:  Make sure the instrument is Active, has a Notification Mailgroup and an HL7 link. 
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Figure 3-16 

 

Use the option “GMRC PROCEDURE SETUP” and verify the Pulmonary procedure is linked to 
a GMRC Procedure. Add the text “Visit Date: |VISIT DATE|“to the first line of the DEAFULT 
REASON FOR REQUEST field. 
 
Select OPTION NAME: GMRC PRO 
     1   GMRC PROCEDURE SETUP       Setup procedures 
     2   GMRC PROTOCOL DETAILED REPORT       Detailed Report of GMRC Protocols 
     3   GMRC PROTOCOL LIST       List GMRC Protocols 
CHOOSE 1-3: 1  GMRC PROCEDURE SETUP     Setup procedures 
Setup procedures 
Select Procedure:CP PULMONARY FUNCTION TEST   
         ...OK? Yes//   (Yes) 
 
NAME: CP PULMONARY FUNCTION TEST  Replace  
INACTIVE: NO//  
Select SYNONYM: PFT//  
INTERNAL NAME:  
Select RELATED SERVICES: PULMONARY//  
TYPE OF PROCEDURE:  
CLINICAL PROCEDURE: PULMONARY PROCEDURES        
  
PREREQUISITE: 
  1> 
PROVISIONAL DX PROMPT: OPTIONAL//  
PROVISIONAL DX INPUT: LEXICON//  
DEFAULT REASON FOR REQUEST: 
  1>Visit Date: |VISIT DATE| 
  2>  
  3>This is a Pulmonary Procedure. 
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RESTRICT DEFAULT REASON EDIT:  
 
Orderable Item Updated 
 

The appointment can either be scheduled prior to the order request or after the order request. The 
appointment has to be for a future date. In the next two figures, they show a scheduled 
appointment to the PFT Lab for an outpatient and a scheduled appointment to Shirl-2 for an 
inpatient. 
 
Appt Mgt Module               Dec 17, 2007@15:13:53          Page:    1 of    1  
Patient: TEST,D (4444)                        MT: REQ                 Outpatient 
Total Appointment Profile        * - New GAF Required     11/17/07 thru 09/11/10 
 
     Clinic                    Appt Date/Time        Status                      
 1   Pft Lab                   12/18/2007@10:00      Future                      
 
 
 
 
 
 
          Enter ?? for more actions                                              
CI  Check In              CD  Change Date Range     DX  Diagnosis Update 
UN  Unscheduled Visit     EP  Expand Entry          DL  Wait List Display 
MA  Make Appointment      AE  Add/Edit              DE  Delete Check Out 
CA  Cancel Appointment    RT  Record Tracking       WD  Wait List Disposition 
NS  No Show               PD  Patient Demographics  CP  Procedure Update 
DC  Discharge Clinic      CO  Check Out             PC  PCMM Assign or Unassign 
AL  Appointment Lists     EC  Edit Classification   TI  Display Team Information 
PT  Change Patient        PR  Provider Update 
CL  Change Clinic         WE  Wait List Entry 
Select Action: Quit// 

 
 
Appt Mgt Module               Dec 17, 2007@15:15:37          Page:    1 of    1  
Patient: TEST,NAJEE (8888)                    MT: NOT REQ              Ward: 3AS 
Total Appointment Profile        * - New GAF Required     11/17/07 thru 09/11/10 
 
     Clinic                    Appt Date/Time        Status                      
 1   Shirl-2                   12/18/2007@11:00      Inpatient/Future            
 
 
 
 
 
 
          Enter ?? for more actions                                              
CI  Check In              CD  Change Date Range     DX  Diagnosis Update 
UN  Unscheduled Visit     EP  Expand Entry          DL  Wait List Display 
MA  Make Appointment      AE  Add/Edit              DE  Delete Check Out 
CA  Cancel Appointment    RT  Record Tracking       WD  Wait List Disposition 
NS  No Show               PD  Patient Demographics  CP  Procedure Update 
DC  Discharge Clinic      CO  Check Out             PC  PCMM Assign or Unassign 
AL  Appointment Lists     EC  Edit Classification   TI  Display Team Information 
PT  Change Patient        PR  Provider Update 
CL  Change Clinic         WE  Wait List Entry 
Select Action: Quit// 
 
 
When you request an order for outpatient, you will be prompted for a visit. 
If the ordering provider selects the appointment during ordering with the procedure, the 
appointment will be selected below. Otherwise, a new visit is created. 
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Figure 3-17 

 
If the GMRC Procedure is set up with the Visit Date text, the visit date/time should be visible in 
the Reason for Request field. If the appointment is selected, the appointment date/time will be 
visible. 
 



Clinical Procedures Process, Part 1 

April 2004 Clinical Procedures V. 1.0 3-23 
 User Manual 

 
Figure 3-18 

 
For the inpatient, the admission date/time will be visible in the Reason for Request field. 
 
After the order is placed for both the inpatient and outpatient, the studies are checked-in for the 
Pulmonary Procedure in CPUser with the status of “New”. 
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Figure 3-19 

 
The status changes to “Pending Instrument Data” on the day of the appointment. 
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Figure 3-20 

 
Note 1: If the status of the study does not change to “Pending Instrument Data” upon the day of 
the appointment, have your IRM Support check if they scheduled the two options MD 
SCHEDULED STUDIES and MD STUDY CHECK-IN to run daily. 
 
Note 2: If the procedure requires multiple encounters, the subsequent appointment scheduled 
will generate a study checked-in on the day of the appointment. If you do not use appointments, 
it is recommended that you do not implement auto check-in for the procedure because you will 
need to manually check-in each subsequent encounter for the procedure. 
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Check-In a New Study  
 
Checking in a new study is the next step in the Clinical Procedures process. You need to check in 
a new study in CP User after a procedure has been ordered. (Keep in mind that the CP check-in 
is not related to the Scheduling check-in process.) 
 
1If you want to link multiple results to one procedure, you can check in multiple studies for the 
same procedure that you ordered through Consults. A warning screen displays telling you that 
this consult procedure order has already been checked in (Figure 3-22). After you ensure that you 
have the correct consult procedure order, you can continue to check in the study. In this way, you 
do not have to order multiple procedure requests. In this example, the colonoscopy procedure 
was ordered and a new study for the colonoscopy procedure is being checked in.   
 

1. To check in a new study, first logon to CP User and select the patient. Refer to Selecting 
a Patient, 2-2. 

 
2. Choose File > Check in New Study to check in the patient. 

 

 
Figure 3-21 

 
3. Select a Consult procedure order for the selected patient. See Figure 3-21. The Clinical 

Procedure column lists the consult procedure orders. Notice that the colonoscopy 
procedure is selected. 

                                                 
1 Patch MD*1.0*4  September 2006  Check in multiple consult procedure orders warning screen added. 
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Note:  You can only select from Clinical Procedure request orders that are in the Pending 
(p), Scheduled (s), Partial Results (pr), Complete (c), and Active (a) statuses. Discontinue 
(d) and Cancel statuses are excluded.  
 
1If the consult procedure order you selected has already been checked in, a warning 
screen displays (Figure 3-22). After you ensure that you have the correct consult 
procedure order, you can continue to check in the study. 
 

 
Figure 3-22 

 
4. Depending on the consult procedure you selected, the appropriate instruments for that 

procedure are displayed. Click the appropriate instrument if more than one is listed, or 
click No Instrument if no instrument is associated with this procedure. OLYMPUS is 
the appropriate instrument in this case and is selected.  

 
5. You must associate each CP study with a PCE visit, which is the hospital location where 

the procedure is performed. Required. 
 

For the majority of TIU notes created through CP, the visit association is completed in 
the background. If a visit has already been recorded but the note wasn’t linked 
(standalone visits, such as telephone or walk-in visits), you can select a visit from the 
Clinical Procedures Check In edit screen (Figure 3-21).  
 
To link the CP study to the visit, select information from the Outpatients Visits tab on 
Figure 3-21. You can also select the New Visit tab and enter NOW for the date and time.  
 

6. Click Check-In. The main CP User window, Figure 3-23, is displayed.  
 

                                                 
1 Patch MD*1.0*4  September 2006  Check in multiple consult procedure orders warning screen added. 



Clinical Procedures Process, Part 1 

3-28 Clinical Procedures V. 1.0 April 2004 
 User Manual 

 
Figure 3-23 

 
7. If the study is checked-in for an instrument with a uni-directional interface, the status is 

Ready to Complete. If the study is checked-in for an instrument supported by a bi-
directional interface, the status is Pending Instrument Data. (Notice on Figure 3-23, the 
colonoscopy status for 3/25 and 3/26 is Pending Instrument Data.) 
 

8. At this point, the clinician performs the procedure on the instrument and transmits the 
results back to VistA. 
 
If the instrument is bi-directional and the Auto Submit to VistA Imaging checkbox is 
selected for the procedure in CP Manager, the study status changes from Pending 
Instrument Data to Complete. This occurs after the result has been transmitted to VistA, 
matched to the study, and copied over to VistA Imaging successfully. The study is ready 
for interpretation. At this time, the CP process is complete and attachments cannot be 
associated with this study. See Clinical Procedures Process, Part 2. 
 
If the instrument is uni-directional or if the instrument is bi-directional and the Auto 
Submit to VistA Imaging checkbox is not selected, the study status is Ready to Complete. 
Go to the next step (9) to manually complete the CP process. 
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9. Open the study (Figure 3-23) and add the instrument results and/or external attachments. 

You can only open studies that have an Error, Complete, Ready to Complete, or New 
status. When a study is in the Ready to Complete or New status, you can open the study 
and finish entering any data that was missed. An example of missed data is an external 
attachment that was not associated with the study.  
  

- Open this study and add results and/or external attachments. Click Open Study or 
select File > Open Study. Figure 3-24 is displayed.  
 

- Click +Results to select and submit the result to Vista Imaging. Only results for 
the patient and instrument used for the procedure are displayed. To select multiple 
results, hold down the CTRL key. To select a range of results, highlight the initial 
result, hold down the Shift key, and then click the last result, Figure 3-25. 
 

- You can also click +Files (Figure 3-24) to add additional attachments from the 
External Attachment Directory. If the External Attachment Directory has not been 
defined for this procedure, the last directory that was accessed may be displayed. 
You can browse for other attachments to link to the study.   

 
Note: If the system parameter Allow Non-Instrument Attachments was not selected 
in CP Manager, +Files does not appear on the Clinical Procedures Study screen, you 
are not permitted to associate additional attachments with the procedure. 
 

10. Submit the study. The images are copied to the RAID and the TIU document is created 
and associated with the procedure order. 
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Figure 3-24 

 
 

 
Figure 3-25 
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11. From Figure 3-24, click the magnifying glass under TIU Note to view the TIU Note for 
that study if it is available. The magnifying glass for the TIU document is unavailable if 
the result has not been submitted to Vista imaging. Once the result is copied to VistA 
Imaging, you can view the TIU document of the study before or after the interpretation 
has been entered, Figure 3-26. 

 

 
Figure 3-26 

 
12. From Figure 3-24, you can also click the magnifying glass under Consult to view the 

Consult report for that study. 
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Figure 3-27 

 
 

Updating Study Status to Correct Errors 
 
If you open a study in the Error status and have the MD MANAGER key, the Update Study 
Status window is displayed. You must have the MD Manager key to access the Update Study 
Status menu option. See your clinical application coordinator or IRM for access to Update Study 
Status. 
 
You can use Update Study Status to change the status of any study. Be careful when changing 
the status of a study. With Update Study Status, you can force a status change of a study if a 
problem occurs that you cannot fix with the Open a Study option. 
 

1. Select File > Update Study Status, Figure 3-28. 
 

2. Select the status you want to change and click OK. 
 

3. After you change the status, choose File > Open a Study and click Submit to resubmit 
the study. 
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Figure 3-28 

 
1Appointment No Shows and Cancellation 
 
When an appointment is scheduled for a future date/time, the appointment can later be cancelled 
or the appointment can be changed to “No show” because the patient was a no show for the 
appointment. With patch MD*1.0*11, an option called MD PROCESS NOSHOW/CANCEL 
was introduced. Once scheduled to run daily, it will pick up the no show and cancelled 
appointments and cancel the associated CP study that was created. 
 
Figure 3-29 shows a study with the status of “New” created from an auto study check-in. 
 

                                                 
1 Patch MD*1.0*11  June 2009 Add new section on appointment no show and cancellation. 
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Figure 3-29 

 
The patient has an appointment scheduled shown in Figure 3-30 for the procedure in Figure 3-29. 
 
Appt Mgt Module               Jul 28, 2008@16:03:25          Page:    1 of    1  
Patient: CP,PATIENTTWO (0343)                                          Ward: 3AS 
Total Appointment Profile        * - New GAF Required     06/28/08 thru 04/23/11 
 
     Clinic                    Appt Date/Time        Status                      
 1   Gi Lab                    07/28/2008@12:00      Inpatient/Act Req     12:00 
 
 
          Enter ?? for more actions                                              
CI  Check In              CD  Change Date Range     DX  Diagnosis Update 
UN  Unscheduled Visit     EP  Expand Entry          DL  Wait List Display 
MA  Make Appointment      AE  Add/Edit              DE  Delete Check Out 
CA  Cancel Appointment    RT  Record Tracking       WD  Wait List Disposition 
NS  No Show               PD  Patient Demographics  CP  Procedure Update 
DC  Discharge Clinic      CO  Check Out             PC  PCMM Assign or Unassign 
AL  Appointment Lists     EC  Edit Classification   TI  Display Team Information 
PT  Change Patient        PR  Provider Update 
CL  Change Clinic         WE  Wait List Entry 
Select Action: Quit//  

Figure 3-30 

 
The appointment was cancelled and re-booked in Figure 3-31. 
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Appt Mgt Module               Jul 28, 2008@16:09:29          Page:    1 of    1  
Patient: CP,PATIENTTWO (0343)                                          Ward: 3AS 
Total Appointment Profile        * - New GAF Required     06/28/08 thru 04/23/11 
 
     Clinic                    Appt Date/Time        Status                      
 1   Gi Lab                    07/28/2008@12:00      Cancelled By Patient        
 2   Gi Lab                    08/08/2008@08:00      Inpatient/Future            
 
 
 
 
 
          Enter ?? for more actions                                              
CI  Check In              CD  Change Date Range     DX  Diagnosis Update 
UN  Unscheduled Visit     EP  Expand Entry          DL  Wait List Display 
MA  Make Appointment      AE  Add/Edit              DE  Delete Check Out 
CA  Cancel Appointment    RT  Record Tracking       WD  Wait List Disposition 
NS  No Show               PD  Patient Demographics  CP  Procedure Update 
DC  Discharge Clinic      CO  Check Out             PC  PCMM Assign or Unassign 
AL  Appointment Lists     EC  Edit Classification   TI  Display Team Information 
PT  Change Patient        PR  Provider Update 
CL  Change Clinic         WE  Wait List Entry 
Select Action: Quit// 

Figure 3-31 

 
Figure 3-32 shows the study cancelled by the task MD PROCESS NOSHOW/CANCEL and a 
new study was generated for the re-booking of the new appointment. 
 

 
Figure 3-32 
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Note:  If during appointment cancellation, no re-booking was selected, the user will need to 
remove the new study created. 
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Figure 3-33 shows an example of an appointment with a status of a “No Show” and no auto re-
booking of a future appointment. 
 
Appt Mgt Module               Jul 30, 2008@09:27:55          Page:    1 of    1  
Patient: CPPATIENT,ONE (0001)                                        Outpatient 
Total Appointment Profile        * - New GAF Required     06/30/08 thru 04/25/11 
 
     Clinic                    Appt Date/Time        Status                      
 1   Gi Lab                    07/30/2008@10:00      No-show     
 
 
 
 
          Enter ?? for more actions                                              
CI  Check In              CD  Change Date Range     DX  Diagnosis Update 
UN  Unscheduled Visit     EP  Expand Entry          DL  Wait List Display 
MA  Make Appointment      AE  Add/Edit              DE  Delete Check Out 
CA  Cancel Appointment    RT  Record Tracking       WD  Wait List Disposition 
NS  No Show               PD  Patient Demographics  CP  Procedure Update 
DC  Discharge Clinic      CO  Check Out             PC  PCMM Assign or Unassign 
AL  Appointment Lists     EC  Edit Classification   TI  Display Team Information 
PT  Change Patient        PR  Provider Update 
CL  Change Clinic         WE  Wait List Entry 
Select Action: Quit// 

Figure 3-33 

 
Figure 3-34 shows the study cancelled for the appointment with “No Show” and a new study is 

created. The user can highlight the study with “New” status and click   button to delete it or 
select the File|| Delete Study to remove it. 
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Figure 3-34 
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4. Clinical Procedures Process, Part 2 
 
This chapter describes the process to follow for completing clinical procedures. (This chapter 
uses the example of completing a colonoscopy to describe the Clinical Procedures process.) Be 
sure to follow the required steps in sequential order. You can do the optional steps as needed. 
 

4. Complete the Procedure. Required 
a. Enter an Interpretation into the TIU note. Required 
b. Enter Encounter information. Required for workload counts 
c. Sign off. Required 

5. View Clinical Procedures results. Optional 
6. Link consent forms and images to Clinical Procedures documents. Optional 

 
 

Completing the Procedure 
 
To complete the procedure, you need to enter the interpretation into the TIU note, enter 
encounter information, and sign off. In this example, the colonoscopy study is being completed.  
 
 
Entering the interpretation into the TIU Note 
 

1. Logon to CPRS. The Patient Selection screen is displayed, Figure 4-1. 
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Figure 4-1 

 
2. In the Notifications box at the bottom of the screen, patients are listed with “Procedure 

ready for interpretation”.   
- Click Process Info if you want to process an informational alert (see left column under 
Notifications, Figure 4-1). 
- Click Process All if you want to process all of the items listed. 
- Click Process if you want to process an item through the Consults tab. 
- Click Remove if you want to remove an item from the list. 
- Click Forward if you want to forward the item to another person. 
 
As part of this example, the patient, CPPATIENT, ONE, is selected. To view results 
through Consults, click Process. The Consults tab is displayed. 
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Figure 4-2 

 
Note the image and note document within the Related Documents window (Figure 4-2). 
 
The consult procedure now has a status of partial results (pr). The CP document has the TIU note 
title. 
 

3. Click the CP title in the Related Documents window. The CP document is displayed in 
the right window, Figure 4-3. 
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Figure 4-3 

 
The Author is not defined, Figure 4-3. This note is automatically created when the instrument 
result is sent and submitted and an author does not exist. The Interpreter who is interpreting the 
result is the default Author. The status of the document is always UNDICTATED when the 
results are ready for interpretation. 
 

4. To select the results that you want to interpret, choose Action > Consult Results > 
Complete/Update Results, Figure 4-4. 
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Figure 4-4 

 
Note: To interpret the result, select the Complete/Update Results option. The Enter Required 
Fields dialog box is displayed, Figure 4-5. The interpreter’s name displays by default in the 
Author field. 
 



Clinical Procedures Process, Part 2 

4-6 Clinical Procedures V. 1.0 April 2004 
 User Manual 

 

 
Figure 4-5 

 
5. Select the appropriate Procedure Summary Code from the list (Figure 4-5). The 

Procedure Summary Codes include Abnormal, Normal, Borderline, and Incomplete. 
 

6. Enter a Procedure Date/Time. Depending on the instrument, the Procedure Date/Time is 
passed in the HL7 message from the instrument. As the interpreter, you can accept the 
default. If the instrument does not pass the Procedure Date/Time, the interpreter has to 
enter a Procedure Date/Time. 

 
The Procedure Summary Code and Procedure Date/Time are required fields for the initial 
note that you are editing. 

 
If you close the Enter Required Fields dialog box without entering the requested information, 
CPRS prompts the interpreter again. 
 
Any subsequent note created on the same procedure after this initial note does not require the 
Procedure Summary Code and Procedure Date/Time fields. The fields are optional on 
subsequent notes. 
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Figure 4-6 

 
7. Enter an interpretation in the space on the right side of the screen for the highlighted 

(current) consult procedure (Figure 4-6). 
 
 
Entering Encounter Information 
 
You can now enter encounter form information. 
 

8. To enter the encounter information and complete the consult procedure, you must select 
Action > Consult Results > Sign Note Now.  

 
You can also select the Encounter drawer (Figure 4-6) to enter encounter information. 
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Figure 4-7 

 
This window (Figure 4-7) asks if you want to enter encounter information now. Figure 4-7 is 
displayed depending on how CPRS parameters are set. See the Implementation Guide for 
information on defining CPRS parameters. 
 

9. Click Yes to enter encounter information, or click No to skip this step. If you choose No, 
you can enter the information at a later time. In this example, the Yes button is clicked 
and encounter information is entered. 

 

 
Figure 4-8 

 
Figure 4-8 allows you to verify the primary provider for this encounter form. 
 

10. Click Yes. 
 
CPRS brings up the Encounter Form that was set up for the Hospital Location, where the 
procedure was performed. The Visit Type tab is displayed. 
 

11. Enter appropriate information for visit type. For example, in Figure 4-9, the following 
information was entered: 
 
Type of Visit. Established Patient 
 
Section Name. Intermediate Exam 11-19 Min. 
 
Visit Related to Service Connected Condition. Yes 
 
Current providers for this encounter. 1CPUSER, ONE  
 

                                                 
1 Patch MD*1.0*11  June 2009 Replaced provider name with generic name.   
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Figure 4-9 

 
12. Click the Diagnoses tab. 
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Figure 4-10 

 
13. Enter appropriate information for diagnoses. See Figure 4-10. 

 
14. Click the Procedures tab. 
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Figure 4-11 

 
15. Enter appropriate procedure information. See Figure 4-11. 

 
16. Click the Exams tab. 
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Figure 4-12 

 
17. Enter appropriate exam information. (See Figure 4-12.) Click OK to return to the 

Consults tab. 
 
 
Signing Off  
 

18. To complete the consult procedure, select Action > Consult Results > Sign Note Now.  
 

 
Figure 4-13 

 
19. Enter your electronic signature to sign the TIU note and complete the consult procedure. 



Clinical Procedures Process, Part 2 

April 2004 Clinical Procedures V. 1.0 4-13 
 User Manual 

 
20. Click OK. 

 

 
Figure 4-14 

 
 The consult procedure now has a status of complete (Figure 4-14). 

 
 The procedure location (GI LAB in Figure 4-14) is used for workload reporting. 

 
 The workload for the procedure goes through the standard TIU interface with PCE 

(Patient Care Encounter). 
 
Even though the consult is complete, you can still attach additional files and studies to the same 
order. 
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1Resulting High Volume Procedures 
 
Patch MD*1.0*21 streamlines the process for high volume procedures such as the 
electrocardiograms.  It reduces the steps for entering the interpretations and completing the 
procedure request for results that have been verified on the medical device. 
 
Make sure the Clinical Application Coordinator and IRM Programmer Support follow the High 
Volume Procedure Checklist in Appendix E – High Volume Procedure Checklist of the Clinical 
Procedures Implementation Guide to implement a high volume procedure.  Once you set up a 
procedure, you can use this functionality. 
 
Do not setup a procedure for high volume, if you do not want to use the auto closure 
functionality and there is no text impression from the device.  You should use the regular CP 
process. 
 
There are multiple ways that the high volume procedure can be processed.  The table below 
shows the different ways: 
 
Procedure              Text          Setup 
Any  No Auto Closure with Proxy User 
EKG(Muse)  Yes Auto Closure with Proxy User,  
  Auto Closure with Muse interpreter, or 
  Significant Findings 
Any  Yes Auto Closure with Proxy User or 
  Significant Findings 

 
Once the procedure is performed and transmitted to VistA, Clinical Procedures will create the 
note with four lines of text and administratively close the note.   This first example shows a 
procedure with no text and it is auto closed by the proxy user with administrative closure. 
 
LOCAL TITLE: CP TEST TITLE                                       
STANDARD TITLE: CARDIOLOGY ATTENDING NOTE                        
DATE OF NOTE: MAR 17, 2009@09:42:05  ENTRY DATE: MAR 17, 2009@09:42:05       
      AUTHOR: CLINICAL,DEVICE PRO  EXP COSIGNER:                            
     URGENCY:                            STATUS: COMPLETED                      
 
** DOCUMENT IN VISTA IMAGING ** 
SEE FULL REPORT IN VISTA IMAGING 
 
SIGNATURE NOT REQUIRED 
SEE SIGNATURE IN VISTA IMAGING 
 
 
Administrative Closure: 03/17/2009 
                    by:  
                        Clinical,Device Proxy Service 

 
 

                                                 
1 Patch MD*1.0*21 June 2010  Add Resulting High Volume Procedures section to Chapter 4. 
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If a procedure is set to get the text impression, Clinical Procedures will add the text into the note 
and administratively close the note. This functionality will only work if the medical device is 
capable of sending the text impression and the result is the final result and was verified on the 
device. Otherwise, the text will not be included in the note. 
 
The next example shows the administratively closed note by the proxy user with the text 
impression added in the note for an EKG. 
 
LOCAL TITLE: CP MUSE EKG                                         
STANDARD TITLE: CARDIOLOGY NOTE                                  
DATE OF NOTE: MAR 17, 2009@08:41:49  ENTRY DATE: MAR 17, 2009@08:41:49       
      AUTHOR: CLINICAL,DEVICE PRO  EXP COSIGNER:                            
     URGENCY:                            STATUS: COMPLETED                      
 
PROCEDURE SUMMARY CODE: Machine Resulted               
DATE/TIME PERFORMED: MAR 17, 2009@08:40:5 
 
** DOCUMENT IN VISTA IMAGING ** 
SEE FULL REPORT IN VISTA IMAGING 
 
SIGNATURE NOT REQUIRED 
SEE SIGNATURE IN VISTA IMAGING 
 
 
** (Muse EKG(Bi-Directional))  AUTO-INSTRUMENT DIAGNOSIS ** 
 
Procedure: 93000  12 Lead ECG 
 
Date Verified: Oct 15, 1998@15:04:18 
 
93000.2  Ventricular Rate:    67      BPM 
  
Administrative Closure: 03/17/2009 
                    by:  
                        Clinical,Device Proxy Service 
 

 
The following example shows an EKG note with the text added, but the note was auto closed by 
the interpreter on the Muse: 
 
LOCAL TITLE: CP MUSE EKG                                         
STANDARD TITLE: CARDIOLOGY NOTE                                  
DATE OF NOTE: JUL 01, 2009@12:00:29  ENTRY DATE: JUL 01, 2009@12:00:29       
      AUTHOR: MUSE,INTERPRETER     EXP COSIGNER:                            
     URGENCY:                            STATUS: COMPLETED                      
 
PROCEDURE SUMMARY CODE: Machine Resulted               
DATE/TIME PERFORMED: AUG 04, 2008@09:00:4 
 
** DOCUMENT IN VISTA IMAGING ** 
SEE FULL REPORT IN VISTA IMAGING 
 
SIGNATURE NOT REQUIRED 
SEE SIGNATURE IN VISTA IMAGING 
 
** (Muse EKG(Bi-Directional))  AUTO-INSTRUMENT DIAGNOSIS ** 
 
Procedure: 93040  12 Lead ECG 
 
Release Status: Released Off-Line Verified 
Date Verified: Aug 04, 2008@09:43:06 
Interpreter: MUSE,INTERPRETER 
 
93000.2  Ventricular Rate:    69      BPM 
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93000.3  Atrial Rate:         69      BPM 
93000.4  P-R Interval:        140     ms 
93000.5  QRS Duration:        100     ms 
93000.6  Q-T Interval:        386     ms 
93000  QTC Calculation(Bezet):413     ms 
93000.12  Calculated P Axis:  75      degrees 
93000.13  Calculated R Axis:  72      degrees 
93000.14  Calculated T Axis:  72      degrees 
Normal sinus rhythm 
Normal ECG 
  
Administrative Closure: 07/01/2009 
                    by: INTERPRETER MUSE 
                        INTERPRETER 

 
The fourth example shows a procedure with the text of the result added to the significant findings 
of the consult and the note remains in the “Undictated” status.  This example is the Detailed 
Consult that has the significant findings and the note displayed: 
 
Current Pat. Status:   Outpatient 
Primary Eligibility:           SC LESS THAN 50% 
 
Order Information 
To Service:            CARDIOLOGY 
From Service:          CARDIOLOGY 
Requesting Provider:   ACKERMAN,TEST 
Service is to be rendered on an OUTPATIENT basis 
Place:                 Consultant's choice 
Urgency:               Routine 
Orderable Item:        CP EP 
Procedure:             CP EP 
Clinical Procedure:    EP 
Reason For Request: 
Colon exam. 
  
Inter-facility Information 
This is not an inter-facility consult request. 
 
Status:                COMPLETE 
Last Action:           COMPLETE/UPDATE 
Significant Findings:  YES 
 
Facility 
 Activity                Date/Time/Zone      Responsible Person  Entered By 
------------------------------------------------------------------------------- 
 CPRS RELEASED ORDER     06/25/09 16:44      ACKERMAN,TEST ACKERMAN,TEST 
 SIG FINDING UPDATE      06/25/09 17:00      CLINICAL,DEVICE P   CLINICAL,DEVICE P 
               (entered) 06/25/09 16:46     
** DOCUMENT IN VISTA IMAGING ** 
SEE FULL REPORT IN VISTA IMAGING 
 
** (DMS (EP))  AUTO-INSTRUMENT DIAGNOSIS ** 
 
Procedure: 99999  Patient Demographics 
 
PT-HT-CM:                     183.00  Cm 
PT-WT-KG:                     86.60   Kg 
PT-BSA:                       2.09    m2 
PT-SEX:                       M 
PT-AGE:                       57.07   Years 
Procedure: 99999  Case Demographics 
 
STUDYUID:                     3081204124528 
STUDYNUM:                     DMS_11716 
CVIS-MODE:                    1 
Procedure: 99999  Event Log 
 
EVENT:                        Protocol: Baseline 
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EVENT:                        ______Pre-Case Documentation______ 
EVENT:                        Patient Arrives 
EVENT:                        Patient on Table 
EVENT:                        Pre-Procedure Teaching Performed 
EVENT:                        Patient Verbalized Understanding of Procedure 
EVENT:                        Consent Signed \T\ On Chart 
EVENT:                        History \T\ Physical On Chart 
EVENT:                        Armband Checked \T\ On Patient 
EVENT:                        _____________________________ 
EVENT:                        No Known Drug Allergies 
EVENT:                        Patient Allergies: 
EVENT:                        IV's Infusing: 
EVENT:                        IV Site: 
EVENT:                        Pre-Case Conscious Sedation Assessment 
EVENT:                        Pre-Procedure Pulses Checked 
EVENT:                        _____________________________ 
EVENT:                        Lab Results Checked 
EVENT:                        Physician Called 
EVENT:                        Patient Prepped \T\ Draped In Usual Manner 
EVENT:                        12-Lead Print 
EVENT:                        __________ EP Procedure__________ 
EVENT:                        Physician Arrived 
EVENT:                        SpO2 99%; HR 88 bpm; 121/88/109 NBP; RR 19/min 
EVENT:                        Case Event - Diagnostic EP 
EVENT:                         
          Case Event Type:Diagnostic EP,Physician:smith,john 
 
EVENT:                        HR 87 bpm; ***/***/*** NBP; RR 19/min 
EVENT:                        Case Start 
EVENT:                        Fentanyl IV 5 mcg 
EVENT:                        Midazolam IV 6 mg 
EVENT:                        Procedure: EP Study with Induction 
EVENT:                        Lidocaine Administrered to: 
EVENT:                        Percutaneous Puncture to: 
EVENT:                        Sheath Inserted 
EVENT:                        8F SR3 8F sheath 
EVENT:                        Catheter Inserted 
EVENT:                        Quadrapolar EP catheter 
EVENT:                        Conduction Intervals 
EVENT:                         
          Case Event Type:Interventional EP,Physician:smith,john 
 
EVENT:                        Arrhy : Tachy 
EVENT:                        Arrhy : Terminated 
EVENT:                        SpO2 94%; HR 187 bpm; 166/110/133 NBP; RR 20/min 
EVENT:                        Arrhy : Tachy 
EVENT:                        Arrhy : Terminated 
EVENT:                        Arrhy : Tachy 
EVENT:                        Arrhy : Terminated 
EVENT:                        Procedure: Mapping 
EVENT:                        Procedure: Electrophysiologic Ablation 
EVENT:                        5031TM Ablation catheter 
EVENT:                        ______Post Case Documentation______ 
EVENT:                        Case End 
EVENT:                        Sheaths Pulled \T\ Manual Pressure Applied 
EVENT:                        Sheaths Sutured In Place 
EVENT:                        Post Case Conscious Sedation Assessment 
EVENT:                        Post Procedure Pulses Checked 
EVENT:                        _____________________________ 
EVENT:                        Hemostasis Obtained 
EVENT:                        Dressing Applied to the Site 
EVENT:                        Post Procedure Teaching Performed 
EVENT:                        Patient Verbalizes Understanding of Teaching 
EVENT:                        Report Called To: 
EVENT:                        Patient Transfered To: 
Procedure: 99999  Conscious Sedation 
 
CS-ACT-PRE:                    
          2 - Able to move 4 extremities voluntarily or on command 
 
CS-ACT-POST:                   
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          0 - Unable to move extremities voluntarily or on command 
 
CS-RESP-PRE:                  2 - Able to breathe deeply and cough freely 
CS-RESP-POST:                 1 - Dyspnea or limited breathing 
CS-CIRC-PRE:                  2 - BP +/- 20% of pre-anesthetic level 
CS-CIRC-POST:                 1 - BP +/- 20% to 49% of pre-anesthetic level 
CS-CONS-PRE:                  2 - Fully Awake 
CS-CONS-POST:                 1 - Arousable on calling 
CS-O2SAT-PRE:                  
          2 - Able to maintain O2 saturation greater than 92% on room air 
 
CS-O2SAT-POST:                 
          1 - Needs O2 inhalation to maintain O2 Saturation greater than 90% 
 
CS-SCORE-PRE:                 10 
CS-SCORE-POST:                4 
Procedure: 99999  XRay Summary 
 
XRAY-FLTIME:                  22.00   min 
XRAY-FLDOSE:                          cGycm2 
XRAY-CINEDOSE:                        cGycm2 
XRAY-TOTDOSE:                         cGycm2 
XRAY-CINEFRAME:                 
XRAY-INTFLTIME:               10.00 
XRAY-DIAGFLTIME:              12.00 
XRAY-TOTALRUNS:                 
Procedure: 99999  DICOM 
 
Event_DICOM_Study:             
          1.2.840.113619.6.209.2667640736.933319371.3302940589.266219474 
 
Procedure: 99999  Reports 
 
Procedure: 99999  Custom_Fields 
 
Procedure: 99999  Registry_Fields 
 
Procedure: 99999  Registry_Fields 
 
Procedure: 0  Study Events 
 
Procedure: 0  Study Events 
 
Procedure: 0  Study Events 
 
Procedure: 99999   
 
 
 
 COMPLETE/UPDATE         12/04/08 12:10      CLINICAL,DEVICE P   ACKERMAN,TEST 
               (entered) 06/25/09 17:20     
     Note# 5835 
 
Note: TIME ZONE is local if not indicated 
 
Significant Findings: **Yes** 
-------------------------------------------------------------------------------- 
 
 LOCAL TITLE: CP CARDIOLOGY                                      
DATE OF NOTE: JUN 25, 2009@16:46:33  ENTRY DATE: JUN 25, 2009@16:46:33       
      AUTHOR:                      EXP COSIGNER:                            
     URGENCY:                            STATUS: UNDICTATED                     
 
PROCEDURE SUMMARY CODE: Machine Resulted               
DATE/TIME PERFORMED: DEC 04, 2008@12:10:0 
 
================================================================================ 
==================================== END ======================================= 
 
Once the note is complete, the Procedure request will be complete. 
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Figure 4-15 

 
On the Consults tab in Computerized Patient Record System (CPRS), the technician can create 
an addendum to the note and enter the encounter form information. Highlight the note that was 
administratively closed. Use the “Action” pull down menu and select Consult Results and then 
select Make Addendum. 
 

 
Figure 4-16 

 
Click on the Encounter button to bring up the Encounter form for the workload. 
 

 
Figure 4-17 
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If you used a Consults title for the note, the note will appear in both the Notes and Consults tab. 
On the Notes tab, you will be able to see the individual note without the procedure request. You 
can highlight the note and click the “Encounter” button to launch the Encounter form. 
 
Note: If you used a Consult title for the note, the Procedure Summary Code and Date/Time 
Performed will not be displayed on the note. 
 

 
Figure 4-18 

 
LOCAL TITLE: CP TEST TITLE                                       
STANDARD TITLE: CARDIOLOGY ATTENDING NOTE                        
DATE OF NOTE: MAR 17, 2009@09:42:05  ENTRY DATE: MAR 17, 2009@09:42:05       
      AUTHOR: CLINICAL,DEVICE PRO  EXP COSIGNER:                            
     URGENCY:                            STATUS: COMPLETED                      
 
** DOCUMENT IN VISTA IMAGING ** 
SEE FULL REPORT IN VISTA IMAGING 
 
SIGNATURE NOT REQUIRED 
SEE SIGNATURE IN VISTA IMAGING 
 
 
** (Muse EKG(Bi-Directional))  AUTO-INSTRUMENT DIAGNOSIS ** 
 
Procedure: 93000  12 Lead ECG 
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Date Verified: Oct 15, 1998@15:04:18 
 
93000.2  Ventricular Rate:    67      BPM 
  
Administrative Closure: 03/17/2009 
                    by:  
                        Clinical,Device Proxy Service 

 
 
 
If you setup the procedure with the text to be entered as significant findings, you will see the 
Detailed Consult on the Consults tab and in the Procedure (local only) component on the Reports 
tab of CPRS. 
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Viewing Clinical Procedures Results 
 
You can go to VistA Imaging to view results. If you as the interpreter did not interpret the result 
right after the procedure was performed, you may want to view the results before you enter an 
interpretation. In the colonoscopy example, the interpretation was entered in Figure 4-6. 
 

1. Logon to CPRS. 
 

2. Select Tools > VistA Imaging Display, Figure 4-19. The patient’s Abstract list is 
displayed, Figure 4-20. 

 

 
Figure 4-19 
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Figure 4-20 

 
Note: VistA Imaging accepts procedure results in .bmp, jpg, jpeg, html, .pdf, .rft, tiff, and .txt 
formats. 

1. Select View > Clinical Procedures to view Clinical Procedures document titles. The list 
of CP documents for the patient is displayed. (Figure 4-21). 

 

 
Figure 4-21 



Clinical Procedures Process, Part 2 

4-24 Clinical Procedures V. 1.0 April 2004 
 User Manual 

 

 
Figure 4-22 

 
2. Click a document title, and then click the camera icon to display the associated images 

for that CP document, Figure 4-22. 
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Figure 4-23 

 
3. Double-click the abstract to open the result file, (Figure 4-23). 

 
4. In the screen where the CP documents are listed, Figure 4-22, click the CP title, and then 

click the report icon next to the camera. The TIU Note is displayed, Figure 4-24. 
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Figure 4-24 

 
Figure 4-24 is an example of a document that has been interpreted and signed. 
 
If you launch Imaging Display before the document is interpreted, the Author field is undefined 
and the status is UNDICTATED. Some users may want to view the results before interpreting. 
 

Linking Consent Forms and Images to CP Documents 
 
As the interpreter, you can link a consent form or other images to CP documents by using VistA 
Imaging Capture. VistA Imaging Capture software can capture clinical images or scanned 
documents and attach them to Clinical Procedures. Refer to the VistA Imaging 3.0 MAG*3.0*7 
Patch Document at the following website: 
 
http://vaww.va.gov/imaging/3.0patches.htm 
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5. 1Viewing the Reports 
 
After installing the Medicine patch MC*2.3*39 and the Clinical Procedures (CP) patch 
MD*1.0*2, you can view the CP interpretations, which are TIU documents, along with Medicine 
reports on the Computerized Patient Record System (CPRS) Reports tab.  
 
Four changes are introduced with patches MC*2.3*39 and MD*1.0*2.  
 

 On the CPRS Reports tab the Medicine folder has been renamed Medicine/CP.   
 The CP procedure interpretations have been added to the list of Medicine procedures for 

viewing and displaying on the CPRS Reports tab.   
o Only completed and signed CP procedures are displayed for CP reports.   
o Unless you are a Subspecialty or a Manager key holder within the Medicine 

package, only released and verified Medicine procedures are displayed for 
Medicine reports. However, if the View All field for a specific procedure in the 
Procedure/Subspecialty (#697.2) file is set to Yes, then all Medicine procedures 
of that type display. 

o If you are a Subspecialty key holder within the Medicine package you can view 
all statuses of Medicine procedures for that subspecialty. 

o If you are a Manager key holder within the Medicine package you can view all 
statuses of Medicine procedures. 

 2The Medicine View file (#690.2) controls which fields are displayed in the Medicine 
reports except for the Procedures (local only) report. Because of the numerous 
background calculations in the PFT report, this report remains unchanged.   

 You can configure the Medicine Report to display in CPRS. See Configuring the 
Medicine Report to Display in CPRS. 

 
The difference between a Medicine Report and a CP Report is that all CP interpretations have a 
consult number associated with them. The interpretation is the TIU document. Medicine reports 
may have a consult procedure request number depending on whether the report was associated 
with a consult request or not. Another difference is that the Medicine report displays the discrete 
data entered through the Medicine package. 
 
You can print these reports by first viewing the report, opening the File menu, and clicking Print. 
Then select a Windows printer to print the report. 
 
The Abnormal, Full Captioned, Full Report, Procedures (local only), and Procedures reports 
display a message at the end of each procedure, which indicates if there are images associated 
with that procedure. The text is as follows: 
NOTE: Images are associated with this procedure. 
      Please use Imaging Display to view the images. 

                                                 
1 Patch MD*1.0*2  July 2004  Viewing the Reports chapter added. 
2 Patch MD*1.0*10  March 2005  Change dealing Medicine View file. 
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After installing MD*1.0*2, your Medicine/CP folder will look similar to the following. (Click on 
a report to view the new format): 
 

Clinical Reports 
Medicine/CP 

Abnormal 
Brief Report 
Full Captioned 
Full Report 
Procedures (local only) 
Procedures 

 
Some of these reports are also located under the Health Summary folder: 

Health Summary 
Ad Hoc Report 

Medicine Abnormal Brief [MEDA] 
Medicine Brief Report [MEDB] 
Medicine Full Captioned [MEDC] 
Medicine Full Report [MEDF] 
Medicine Summary [MEDS] – This is a listing of procedure headings that fall within 
a specified date range. 

 
The Procedures (local only) report can also be found under the list of Available Reports. 
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Abnormal 
 
This report shows all Medicine and CP interpretations that have a Procedure Summary Code of 
Abnormal. The name of the report, selected date range and maximum number of occurrences 
(Max/site) appear above the report. 
 
Medicine/CP Abnormal [From: May 4, 2003 to May 3, 2004] Max/site: 10 
Printed for data from 05/04/2003 to 05/03/2004                 05/03/2004 13:16 
***********************  CONFIDENTIAL  SUMMARY   pg. 1 ************************ 
CPPATIENT1, TEN    000-00-0110        3AS                       DOB: 02/03/1943 
 
----------------------------- MEDA - Med Abnormal ----------------------------- 
                                   
 
------------------------------------------------------------------------------- 
            COLONOSCOPY                     APR 16,2004@15:38   ABNORMAL 
------------------------------------------------------------------------------- 
 
APPOINTMENT DATE/TIME:   4/16/04@15:38 
MEDICAL PATIENT:   CPPATIENT1, TEN 
PROTOCOL:   STOMACH TEST 
EGD SIMPLE PRIMARY EXAM:   Y 
LAB OR XRAY:   LAB 
OCCULT BLOOD:    
SPECIMEN COLLECTION:    
INDICATION COMMENT:   TESTING 
  
LOCATION EVALUATED:  
  COLON ASCENDING 
     GROSS: ABSENCE 
     MEASUREMENT:  
     IMPRESSION:  
FELLOW:    
SUMMARY:   ABNORMAL 
PRIMARY DIAGNOSIS:    
PROCEDURE SUMMARY:   TESTING THE PROCEDURE 
  
INSTRUMENT:  
  SCOPE 1 
ENDOSCOPIST:   CPPROVIDER1, SEVEN 
WHERE PERFORMED:    
WARD/CLINIC:   GI LAB 
TIME STARTED:   0600 
TIME COMPLETED:   1000 
URGENCY OF PROCEDURE:   ELECTIVE 
PREPARATION DIET:   CLEAR LIQUIDS 
DIET COMMENT:    
ENEMAS:   PHOSPHASODA 
COMMON BILE DUCT SIZE (mm):    
PANCREATIC DUCT SIZE (mm):    
DEPTH OF INSERTION:    
POST-PROC INSTRUMENT CLEANSING:    
SECOND FELLOW:    
  
INSTRUCTIONS TO PATIENT:  
  
------------------------------------------------------------------------------- 
            PULMONARY FUNCTION TEST         MAR 16,2004@13:40   ABNORMAL 
------------------------------------------------------------------------------- 
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SEX: M  AGE: 61          90 in/160 lb                       AMBIENT: 35C/600T 
RACE: WHITE, NOT OF HISPANIC ORIGIN                         TECH: CPUSER, TEN 
SMOKER                        CURRENT BRONCHODILATOR USE    EFFORT: GOOD 
  
CONSULT DX:  
               COUGH 
               ASTHMA 
               INTERSTITIAL LUNG DISEASE 
................................................................................ 
  
  
               UNITS     PRED      ACTUAL     %PRED    PREV1     PREV2   CI 
VOLUMES......................................................................... 
  
     INERT GAS DILUTION                                6/30/03   6/6/02 
(NOTES): TEST INERT GAS 
     TLC          L      10.53      9.00      85.5      5.00      8.00     9.09 
     VC           L       7.76      3.00      38.7      7.00      7.00 
     FRC          L       4.38      4.00      91.4      3.00      6.50  U  5.42 
     RV           L       2.80      5.00     178.3      4.00      4.00  U  3.68 
     RV/TLC       %                   56 
  
     BODY BOX                                          6/30/03   6/6/02 
(NOTES): TEST BODY BOX 
     TLC          L      10.53      3.00      28.5      7.00      9.90     9.09 
     VC           L       7.76      2.00      25.8      6.00      7.00 
     FRC          L       4.38      4.00      91.4      4.00      6.00  U  5.42 
     RV           L       2.80      5.00     178.3      2.00      5.00  U  3.68 
     RV/TLC       %                  167 
  
     NITROGEN WASH OUT                                 6/6/02    5/31/02 
(NOTES): TEST NITROGEN WASH OUT 
     TLC          L      10.53      7.00      66.5      6.00      7.00     9.09 
     VC           L       7.76      4.00      51.5      5.50      6.00 
     FRC          L       4.38      3.00      68.6      4.00      4.00  U  5.42 
     RV           L       2.80      2.00      71.3      3.00      3.00  U  3.68 
     RV/TLC       %                   29 
  
     X-RAY PLANIMETRY                                  6/6/02    5/30/02 
(NOTES): TEST X-RAY 
     TLC          L      10.53      5.00      47.5      7.00      9.00     9.09 
     VC           L       7.76      4.00      51.5      6.40      6.00 
     FRC          L       4.38      7.00     160.0      3.00      4.00  U  5.42 
     RV           L       2.80      8.00     285.2      1.00      5.00  U  3.68 
     RV/TLC       %                  160 
  
  
               UNITS     PRED      ACTUAL     %PRED    PREV1     PREV2   CI 
FLOWS........................................................................... 
  
MACHINE: FLOW TURBINE 
  
    STANDARD STUDY                                     6/6/02    5/30/02 
    (NOTES): TEST STANDARD 
     FVC       L          7.76      4.30      55.4      8.00      9.00 
     FEV1      L          5.79      2.20      38.0      6.00      4.00    4.94 
     PF        L/SEC     10.986     3.200     29.1      5.000     5.000   8.02 
     FEF25-75  L/SEC      4.478     4.500    100.5      4.000    15.000   2.81 
     MVV       L/MIN     211.72     3.00       1.4      4.00     10.00  163.87 
     FEV1/FVC    %                    51 
  
    AFTER INHALATION CHALLENGE                         6/6/02    5/31/02 
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    (NOTES): AFTER INHALATION 
     FVC       L          7.76      7.00      90.2      8.00      9.00 
     FEV1      L          5.79      4.00      69.1      7.00      8.00    4.94 
     PF        L/SEC     10.986     3.000     27.3      6.000     7.000   8.02 
     FEF25-75  L/SEC      4.478     5.000    111.6      5.000    10.000   2.81 
     MVV       L/MIN     211.72     3.00       1.4      4.00     50.00  163.87 
     FEV1/FVC    %                    57 
  
    AFTER EXERCISE                                     6/6/02    5/31/02 
     FVC       L          7.76      5.00      64.4      8.00      9.90 
     FEV1      L          5.79      3.00      51.9      7.00      8.00    4.94 
     PF        L/SEC     10.986     2.000     18.2      6.000     7.000   8.02 
     FEV1/FVC    %                    60 
  
DIFFUSION....................................................................... 
  METHOD: STEADY STATE 
                                                       6/30/03   6/6/02 
     DLCO-SB   L         37.16     33.00      88.8     45.00     50.00   29.18 
Corr DLCO for HB & COHB: 37.16     32.55      87.6 
  
  
BLOOD GASES..................................................................... 
  
  
STUDY TYPE      pH    pCO2  pO2     O2HB   COHB MHB    HB   FiO2 A-aO2  QS/QT 
  (NORMAL)  7.36-7.44 36-44 80-100 >88%    <3%  <2%              <22 
100% O2 STUDY  7.000   0.0   0.0    4.0%   0.0% 0.0%   3.0 0.500  277  
PATIENT TEMPERATURE (C): 35 
MAX EXERCISE   8.000  44.0   3.0   53.0%  33.0%23.0%  15.4 0.343  132  
PATIENT TEMPERATURE (C): 30 
(NOTES): TEST QS 
SUPPLEMENTAL   8.000   9.0   0.0   67.0%   0.0%56.0%   0.0 0.900  486  
PATIENT TEMPERATURE (C): 32 
POST EXERCISE  7.456  99.0 345.0   78.0%  45.0%45.0%  15.1 1.000   84   0.52 
PATIENT TEMPERATURE (C): 33 
(NOTES): TEST QS 
  
  
  
  
               UNITS               ACTUAL              PREV1     PREV2 
SPECIAL STUDIES................................................................. 
  
     MAXIMUM PRESSURES                                 6/30/03   6/6/02 
    (NOTES): 44 
     PiMAX        cmH2O             5.00               99.00     68.00 
  
     MECHANICS                                         6/30/03   6/6/02 
     Raw          cmH20/L/S         4.00               15.00     10.00 
     SGaw         L/S/cmH20         0.30                0.30      0.20 
     Cst          4cmH20            0.50                1.00      0.40 
  
     SMALL AIRWAY                                      6/30/03   6/6/02 
     Cdyn         L/cmH20           0.40                1.00      0.45 
     FEF50 He-Air L/Sec            45.00               45.00     56.00 
     VISOV        L                 3.00                5.00      5.00 
     CV           L                 5.00                4.00      5.00 
     CV/VC        %                 2.50      
     CV/TLC       %                 1.67 
     VISOV/CV     %                 0.60 
  
     EXERCISE                                          6/30/03   6/6/02 
    (NOTES): Insert note here 
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     VEmax(BTPS)  L                44.00               90.00     90.00 
     BR           L                34.00               50.00     50.00 
     VD/VT MAX    L                 0.70                          0.43 
     VErest(BTPS) ml/beat           3.00               35.00     30.00 
     EKG                           ABNORMAL 
     Wmax         wrpm/min          2.00               100.00    245.00 
     WRI/WRT      watts/min         3.00               35.00     40.00 
     Max Speed    mph              15.00               20.00     15.00 
     TOTAL TIME   min              100.00              100.00    600.00 
Exercise Testing Mode: BIKE ERGOMETER 
REASON(S) FOR STOPPING: 
                           Patient cannot work on Bike Treadmill anymore.  
                           he will work on something different such as a 
                           Cardioglider. 
  
INTERPRETATION: 
  
COMMENTS AND RECOMMENDATIONS: 
  
INTERPRETED BY:  
                SMITH,JOE 
  
  
  
                        PREDICTED VALUE FORMULAS USED 
    TLC              .078*HT-7.3                  BOREN & KORY '66 
    VC               .06*HT-(.0214*AGE)-4.65      CRAPO '81 
    FRC              .032*HT-2.94                 BOREN & KOREY '66 
    RV               .019*HT+(.0115*AGE)-2.24     BOREN & KORY '66 
    FVC              .06*HT-(.0214*AGE)-4.65      CRAPO '81 
    FEV1             .0414*HT-(.0244*AGE)-2.190   CRAPO '81 
    PF               3.9*HT-(3*AGE)-49.36/60      FERRIS '64 
    FEF25-75         .0204*HT-(.038*AGE)+2.133    CRAPO '81 
    MVV              1.356*HT-(1.26*AGE)-21.4     BOREN & KOREY '66 
    DLCO-SB          12.9113-(.229*AGE)+(.1672*HT) MILLER '83 
    COHB CORR.       ACT*(1+(COHB/100))           MORRIS '85 
    HB CORR.         HB+10.22/(1.7*HB)*ACT        COTES '72 
NOTE:  HT=height,WT=weight,ACT=actual measurement value 
*** END ***************  CONFIDENTIAL  SUMMARY   pg. 1 *********************** 
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Brief Report 
 
This report lists all procedures (Medicine and CP) that fall within a specified date range and the 
maximum number of occurrences (Max/site). The name of the report, selected date range and 
maximum number of occurrences (Max/site) appear above the report. These procedures are listed 
according to Consult Number, Completed Procedures, Date/Time Performed, and Procedure 
Code (also known as Procedure Summary Code). 
 
Medicine/CP Brief Report [From: May 4, 2003 to May 3, 2004] Max/site: 10 
Printed for data from 05/04/2003 to 05/03/2004                 05/03/2004 13:22 
***********************  CONFIDENTIAL  SUMMARY   pg. 1 ************************ 
CPPATIENT1, TEN    000-00-0110        3AS                       DOB: 02/03/1943 
 
--------------------------- MEDB - Med Brief Report --------------------------- 
                                   
  CONSULT                                   DATE/TIME 
   NUMBER   COMPLETED PROCEDURES            PERFORMED              PROCEDURE CODE 
  -------   ------------------------------  ----------------       ----------------- 
 
            COLONOSCOPY                     APR 16,2004@15:38      ABNORMAL 
            PULMONARY FUNCTION TEST         MAR 30,2004@13:43       
            PULMONARY FUNCTION TEST         MAR 16,2004@13:40      ABNORMAL 
            ELECTROPHYSIOLOGY               JUN 30,2003@10:40      ABNORMAL 
            PULMONARY FUNCTION TEST         JUN 30,2003@09:37      NORMAL 
*** END ***************  CONFIDENTIAL  SUMMARY   pg. 1 *********************** 
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Full Captioned 
 
This report shows all Medicine and CP reports within a specified date range and the maximum 
number of occurrences (Max/site). The name of the report, selected date range and maximum 
number of occurrences (Max/site) appear above the report. Fields that do not contain data within 
the Medicine reports do not display. 
 
Medicine/CP Full Captioned [From: May 20, 2003 to May 19, 2004] Max/site: 10 
Printed for data from 05/20/2003 to 05/19/2004                 05/19/2004 14:54 
***********************  CONFIDENTIAL  SUMMARY   pg. 1 ************************ 
CPPATIENT1, TEN    000-00-0110        3AS                       DOB: 02/03/1943 
 
-------------------------- MEDC - Med Full Captioned -------------------------- 
                                   
 
------------------------------------------------------------------------------- 
            COLONOSCOPY                     APR 16,2004@15:38   ABNORMAL 
------------------------------------------------------------------------------- 
 
APPOINTMENT DATE/TIME:   4/16/04@15:38 
MEDICAL PATIENT:   CPPATIENT1, TEN 
PROTOCOL:   STOMACH TEST 
EGD SIMPLE PRIMARY EXAM:   Y 
LAB OR XRAY:   LAB 
INDICATION COMMENT:   TESTING 
  
LOCATION EVALUATED:  
  COLON ASCENDING 
     GROSS: ABSENCE 
SUMMARY:   ABNORMAL 
PROCEDURE SUMMARY:   TESTING THE PROCEDURE 
  
INSTRUMENT:  
  SCOPE 1 
ENDOSCOPIST:   CPPROVIDER1, SEVEN 
WARD/CLINIC:   GI LAB 
TIME STARTED:   0600 
TIME COMPLETED:   1000 
URGENCY OF PROCEDURE:   ELECTIVE 
PREPARATION DIET:   CLEAR LIQUIDS 
ENEMAS:   PHOSPHASODA 
------------------------------------------------------------------------------- 
            PULMONARY FUNCTION TEST         MAR 30,2004@13:43    
------------------------------------------------------------------------------- 
 
SEX: M  AGE: 61          85 in/167 lb                       AMBIENT: 35C/600T 
RACE: WHITE, NOT OF HISPANIC ORIGIN                         TECH: CPUSER, TEN 
NON-SMOKER                    CURRENT BRONCHODILATOR USE    EFFORT: GOOD 
  
CONSULT DX:  
               COUGH 
................................................................................ 
  
  
               UNITS     PRED      ACTUAL     %PRED    PREV1     PREV2   CI 
VOLUMES......................................................................... 
  
     BODY BOX                                          3/16/04   6/30/03 
     TLC          L       9.54      2.00      21.0      3.00      7.00     8.10 
     VC           L       7.00      3.00      42.9      2.00      6.00 
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     FRC          L       3.97      4.00     100.8      4.00      4.00  U  5.01 
     RV           L       2.56      5.00     195.0      5.00      2.00  U  3.44 
     RV/TLC       %                  250 
  
INTERPRETATION: 
  
COMMENTS AND RECOMMENDATIONS: 
  
INTERPRETED BY:  
  
  
  
                        PREDICTED VALUE FORMULAS USED 
    TLC              .078*HT-7.3                  BOREN & KORY '66 
    VC               .06*HT-(.0214*AGE)-4.65      CRAPO '81 
    FRC              .032*HT-2.94                 BOREN & KOREY '66 
    RV               .019*HT+(.0115*AGE)-2.24     BOREN & KORY '66 
    FVC              .06*HT-(.0214*AGE)-4.65      CRAPO '81 
    FEV1             .0414*HT-(.0244*AGE)-2.190   CRAPO '81 
    PF               3.9*HT-(3*AGE)-49.36/60      FERRIS '64 
    FEF25-75         .0204*HT-(.038*AGE)+2.133    CRAPO '81 
    MVV              1.356*HT-(1.26*AGE)-21.4     BOREN & KOREY '66 
    DLCO-SB          12.9113-(.229*AGE)+(.1672*HT) MILLER '83 
    COHB CORR.       ACT*(1+(COHB/100))           MORRIS '85 
    HB CORR.         HB+10.22/(1.7*HB)*ACT        COTES '72 
NOTE:  HT=height,WT=weight,ACT=actual measurement value 
------------------------------------------------------------------------------- 
            PULMONARY FUNCTION TEST         MAR 16,2004@13:40   ABNORMAL 
------------------------------------------------------------------------------- 
 
SEX: M  AGE: 61          90 in/160 lb                       AMBIENT: 35C/600T 
RACE: WHITE, NOT OF HISPANIC ORIGIN                         TECH: CPUSER, TEN 
SMOKER                        CURRENT BRONCHODILATOR USE    EFFORT: GOOD 
  
CONSULT DX:  
               COUGH 
               ASTHMA 
               INTERSTITIAL LUNG DISEASE 
................................................................................ 
  
  
               UNITS     PRED      ACTUAL     %PRED    PREV1     PREV2   CI 
VOLUMES......................................................................... 
  
     INERT GAS DILUTION                                6/30/03   6/6/02 
(NOTES): TEST INERT GAS 
     TLC          L      10.53      9.00      85.5      5.00      8.00     9.09 
     VC           L       7.76      3.00      38.7      7.00      7.00 
     FRC          L       4.38      4.00      91.4      3.00      6.50  U  5.42 
     RV           L       2.80      5.00     178.3      4.00      4.00  U  3.68 
     RV/TLC       %                   56 
  
     BODY BOX                                          6/30/03   6/6/02 
(NOTES): TEST BODY BOX 
     TLC          L      10.53      3.00      28.5      7.00      9.90     9.09 
     VC           L       7.76      2.00      25.8      6.00      7.00 
     FRC          L       4.38      4.00      91.4      4.00      6.00  U  5.42 
     RV           L       2.80      5.00     178.3      2.00      5.00  U  3.68 
     RV/TLC       %                  167 
  
     NITROGEN WASH OUT                                 6/6/02    5/31/02 
(NOTES): TEST NITROGEN WASH OUT 
     TLC          L      10.53      7.00      66.5      6.00      7.00     9.09 
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     VC           L       7.76      4.00      51.5      5.50      6.00 
     FRC          L       4.38      3.00      68.6      4.00      4.00  U  5.42 
     RV           L       2.80      2.00      71.3      3.00      3.00  U  3.68 
     RV/TLC       %                   29 
  
     X-RAY PLANIMETRY                                  6/6/02    5/30/02 
(NOTES): TEST X-RAY 
     TLC          L      10.53      5.00      47.5      7.00      9.00     9.09 
     VC           L       7.76      4.00      51.5      6.40      6.00 
     FRC          L       4.38      7.00     160.0      3.00      4.00  U  5.42 
     RV           L       2.80      8.00     285.2      1.00      5.00  U  3.68 
     RV/TLC       %                  160 
  
  
               UNITS     PRED      ACTUAL     %PRED    PREV1     PREV2   CI 
FLOWS........................................................................... 
  
MACHINE: FLOW TURBINE 
  
    STANDARD STUDY                                     6/6/02    5/30/02 
    (NOTES): TEST STANDARD 
     FVC       L          7.76      4.30      55.4      8.00      9.00 
     FEV1      L          5.79      2.20      38.0      6.00      4.00    4.94 
     PF        L/SEC     10.986     3.200     29.1      5.000     5.000   8.02 
     FEF25-75  L/SEC      4.478     4.500    100.5      4.000    15.000   2.81 
     MVV       L/MIN     211.72     3.00       1.4      4.00     10.00  163.87 
     FEV1/FVC    %                    51 
  
    AFTER INHALATION CHALLENGE                         6/6/02    5/31/02 
    (NOTES): AFTER INHALATION 
     FVC       L          7.76      7.00      90.2      8.00      9.00 
     FEV1      L          5.79      4.00      69.1      7.00      8.00    4.94 
     PF        L/SEC     10.986     3.000     27.3      6.000     7.000   8.02 
     FEF25-75  L/SEC      4.478     5.000    111.6      5.000    10.000   2.81 
     MVV       L/MIN     211.72     3.00       1.4      4.00     50.00  163.87 
     FEV1/FVC    %                    57 
  
    AFTER EXERCISE                                     6/6/02    5/31/02 
     FVC       L          7.76      5.00      64.4      8.00      9.90 
     FEV1      L          5.79      3.00      51.9      7.00      8.00    4.94 
     PF        L/SEC     10.986     2.000     18.2      6.000     7.000   8.02 
     FEV1/FVC    %                    60 
  
DIFFUSION....................................................................... 
  METHOD: STEADY STATE 
                                                       6/30/03   6/6/02 
     DLCO-SB   L         37.16     33.00      88.8     45.00     50.00   29.18 
Corr DLCO for HB & COHB: 37.16     32.55      87.6 
  
  
BLOOD GASES..................................................................... 
  
  
STUDY TYPE      pH    pCO2  pO2     O2HB   COHB MHB    HB   FiO2 A-aO2  QS/QT 
  (NORMAL)  7.36-7.44 36-44 80-100 >88%    <3%  <2%              <22 
100% O2 STUDY  7.000   0.0   0.0    4.0%   0.0% 0.0%   3.0 0.500  277  
PATIENT TEMPERATURE (C): 35 
MAX EXERCISE   8.000  44.0   3.0   53.0%  33.0%23.0%  15.4 0.343  132  
PATIENT TEMPERATURE (C): 30 
(NOTES): TEST QS 
SUPPLEMENTAL   8.000   9.0   0.0   67.0%   0.0%56.0%   0.0 0.900  486  
PATIENT TEMPERATURE (C): 32 
POST EXERCISE  7.456  99.0 345.0   78.0%  45.0%45.0%  15.1 1.000   84   0.52 



Viewing the Reports 

April 2004 Clinical Procedures V. 1.0 5-11 
 User Manual 

PATIENT TEMPERATURE (C): 33 
(NOTES): TEST QS 
  
  
  
  
               UNITS               ACTUAL              PREV1     PREV2 
SPECIAL STUDIES................................................................. 
  
     MAXIMUM PRESSURES                                 6/30/03   6/6/02 
    (NOTES): 44 
     PiMAX        cmH2O             5.00               99.00     68.00 
  
     MECHANICS                                         6/30/03   6/6/02 
     Raw          cmH20/L/S         4.00               15.00     10.00 
     SGaw         L/S/cmH20         0.30                0.30      0.20 
     Cst          4cmH20            0.50                1.00      0.40 
  
     SMALL AIRWAY                                      6/30/03   6/6/02 
     Cdyn         L/cmH20           0.40                1.00      0.45 
     FEF50 He-Air L/Sec            45.00               45.00     56.00 
     VISOV        L                 3.00                5.00      5.00 
     CV           L                 5.00                4.00      5.00 
     CV/VC        %                 2.50      
     CV/TLC       %                 1.67 
     VISOV/CV     %                 0.60 
  
     EXERCISE                                          6/30/03   6/6/02 
    (NOTES): Insert note here 
     VEmax(BTPS)  L                44.00               90.00     90.00 
     BR           L                34.00               50.00     50.00 
     VD/VT MAX    L                 0.70                          0.43 
     VErest(BTPS) ml/beat           3.00               35.00     30.00 
     EKG                           ABNORMAL 
     Wmax         wrpm/min          2.00               100.00    245.00 
     WRI/WRT      watts/min         3.00               35.00     40.00 
     Max Speed    mph              15.00               20.00     15.00 
     TOTAL TIME   min              100.00              100.00    600.00 
Exercise Testing Mode: BIKE ERGOMETER 
REASON(S) FOR STOPPING: 
                           Patient cannot work on Bike Treadmill anymore.  
                           he will work on something different such as a 
                           Cardioglider. 
  
INTERPRETATION: 
  
COMMENTS AND RECOMMENDATIONS: 
  
INTERPRETED BY:  
                CPUSER, TEN 
  
  
  
                        PREDICTED VALUE FORMULAS USED 
    TLC              .078*HT-7.3                  BOREN & KORY '66 
    VC               .06*HT-(.0214*AGE)-4.65      CRAPO '81 
    FRC              .032*HT-2.94                 BOREN & KOREY '66 
    RV               .019*HT+(.0115*AGE)-2.24     BOREN & KORY '66 
    FVC              .06*HT-(.0214*AGE)-4.65      CRAPO '81 
    FEV1             .0414*HT-(.0244*AGE)-2.190   CRAPO '81 
    PF               3.9*HT-(3*AGE)-49.36/60      FERRIS '64 
    FEF25-75         .0204*HT-(.038*AGE)+2.133    CRAPO '81 
    MVV              1.356*HT-(1.26*AGE)-21.4     BOREN & KOREY '66 
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    DLCO-SB          12.9113-(.229*AGE)+(.1672*HT) MILLER '83 
    COHB CORR.       ACT*(1+(COHB/100))           MORRIS '85 
    HB CORR.         HB+10.22/(1.7*HB)*ACT        COTES '72 
NOTE:  HT=height,WT=weight,ACT=actual measurement value 
*** END ***************  CONFIDENTIAL  SUMMARY   pg. 1 *********************** 
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Full Report 
 
This report shows all Medicine and CP reports within a specified date range and the maximum 
number of occurrences (Max/site). The name of the report, selected date range and maximum 
number of occurrences (Max/site) appear above the report. All data fields, including null values, 
are displayed. 
 
Medicine/CP Full Report [From: May 20, 2003 to May 19, 2004] Max/site: 10 
Printed for data from 05/20/2003 to 05/19/2004                 05/19/2004 13:25 
***********************  CONFIDENTIAL  SUMMARY   pg. 1 ************************ 
CPPATIENT1, TEN    000-00-0110        3AS                       DOB: 02/03/1943 
  
--------------------------- MEDF - Med Full Report --------------------------- 
                                   
 
------------------------------------------------------------------------------- 
            COLONOSCOPY                     APR 16,2004@15:38   ABNORMAL 
------------------------------------------------------------------------------- 
 
APPOINTMENT DATE/TIME:   4/16/04@15:38 
MEDICAL PATIENT:   CPPATIENT1, TEN 
PROTOCOL:   STOMACH TEST 
EGD SIMPLE PRIMARY EXAM:   Y 
LAB OR XRAY:   LAB 
OCCULT BLOOD:    
SPECIMEN COLLECTION:    
INDICATION COMMENT:   TESTING 
  
LOCATION EVALUATED:  
  COLON ASCENDING 
     GROSS: ABSENCE 
     MEASUREMENT:  
     IMPRESSION:  
FELLOW:    
SUMMARY:   ABNORMAL 
PRIMARY DIAGNOSIS:    
PROCEDURE SUMMARY:   TESTING THE PROCEDURE 
  
INSTRUMENT:  
  SCOPE 1 
ENDOSCOPIST:   CPPROVIDER1, SEVEN 
WHERE PERFORMED:    
WARD/CLINIC:   GI LAB 
TIME STARTED:   0600 
TIME COMPLETED:   1000 
URGENCY OF PROCEDURE:   ELECTIVE 
PREPARATION DIET:   CLEAR LIQUIDS 
DIET COMMENT:    
ENEMAS:   PHOSPHASODA 
COMMON BILE DUCT SIZE (mm):    
PANCREATIC DUCT SIZE (mm):    
DEPTH OF INSERTION:    
POST-PROC INSTRUMENT CLEANSING:    
SECOND FELLOW:    
  
INSTRUCTIONS TO PATIENT:  
  
------------------------------------------------------------------------------- 
            PULMONARY FUNCTION TEST         MAR 30,2004@13:43    
------------------------------------------------------------------------------- 
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SEX: M  AGE: 61          85 in/167 lb                       AMBIENT: 35C/600T 
RACE: WHITE, NOT OF HISPANIC ORIGIN                         TECH: CPUSER1, ONE 
NON-SMOKER                    CURRENT BRONCHODILATOR USE    EFFORT: GOOD 
  
CONSULT DX:  
               COUGH 
................................................................................ 
  
  
               UNITS     PRED      ACTUAL     %PRED    PREV1     PREV2   CI 
VOLUMES......................................................................... 
  
     BODY BOX                                          3/16/04   6/30/03 
     TLC          L       9.54      2.00      21.0      3.00      7.00     8.10 
     VC           L       7.00      3.00      42.9      2.00      6.00 
     FRC          L       3.97      4.00     100.8      4.00      4.00  U  5.01 
     RV           L       2.56      5.00     195.0      5.00      2.00  U  3.44 
     RV/TLC       %                  250 
  
INTERPRETATION: 
  
COMMENTS AND RECOMMENDATIONS: 
  
INTERPRETED BY:  
  
  
  
                        PREDICTED VALUE FORMULAS USED 
    TLC              .078*HT-7.3                  BOREN & KORY '66 
    VC               .06*HT-(.0214*AGE)-4.65      CRAPO '81 
    FRC              .032*HT-2.94                 BOREN & KOREY '66 
    RV               .019*HT+(.0115*AGE)-2.24     BOREN & KORY '66 
    FVC              .06*HT-(.0214*AGE)-4.65      CRAPO '81 
    FEV1             .0414*HT-(.0244*AGE)-2.190   CRAPO '81 
    PF               3.9*HT-(3*AGE)-49.36/60      FERRIS '64 
    FEF25-75         .0204*HT-(.038*AGE)+2.133    CRAPO '81 
    MVV              1.356*HT-(1.26*AGE)-21.4     BOREN & KOREY '66 
    DLCO-SB          12.9113-(.229*AGE)+(.1672*HT) MILLER '83 
    COHB CORR.       ACT*(1+(COHB/100))           MORRIS '85 
    HB CORR.         HB+10.22/(1.7*HB)*ACT        COTES '72 
NOTE:  HT=height,WT=weight,ACT=actual measurement value 
------------------------------------------------------------------------------- 
            PULMONARY FUNCTION TEST         MAR 16,2004@13:40   ABNORMAL 
------------------------------------------------------------------------------- 
 
SEX: M  AGE: 61          90 in/160 lb                       AMBIENT: 35C/600T 
RACE: WHITE, NOT OF HISPANIC ORIGIN                         TECH: CPUSER, TEN 
SMOKER                        CURRENT BRONCHODILATOR USE    EFFORT: GOOD 
  
CONSULT DX:  
               COUGH 
               ASTHMA 
               INTERSTITIAL LUNG DISEASE 
................................................................................ 
  
  
               UNITS     PRED      ACTUAL     %PRED    PREV1     PREV2   CI 
VOLUMES......................................................................... 
  
     INERT GAS DILUTION                                6/30/03   6/6/02 
(NOTES): TEST INERT GAS 
     TLC          L      10.53      9.00      85.5      5.00      8.00     9.09 
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     VC           L       7.76      3.00      38.7      7.00      7.00 
     FRC          L       4.38      4.00      91.4      3.00      6.50  U  5.42 
     RV           L       2.80      5.00     178.3      4.00      4.00  U  3.68 
     RV/TLC       %                   56 
  
     BODY BOX                                          6/30/03   6/6/02 
(NOTES): TEST BODY BOX 
     TLC          L      10.53      3.00      28.5      7.00      9.90     9.09 
     VC           L       7.76      2.00      25.8      6.00      7.00 
     FRC          L       4.38      4.00      91.4      4.00      6.00  U  5.42 
     RV           L       2.80      5.00     178.3      2.00      5.00  U  3.68 
     RV/TLC       %                  167 
  
     NITROGEN WASH OUT                                 6/6/02    5/31/02 
(NOTES): TEST NITROGEN WASH OUT 
     TLC          L      10.53      7.00      66.5      6.00      7.00     9.09 
     VC           L       7.76      4.00      51.5      5.50      6.00 
     FRC          L       4.38      3.00      68.6      4.00      4.00  U  5.42 
     RV           L       2.80      2.00      71.3      3.00      3.00  U  3.68 
     RV/TLC       %                   29 
  
     X-RAY PLANIMETRY                                  6/6/02    5/30/02 
(NOTES): TEST X-RAY 
     TLC          L      10.53      5.00      47.5      7.00      9.00     9.09 
     VC           L       7.76      4.00      51.5      6.40      6.00 
     FRC          L       4.38      7.00     160.0      3.00      4.00  U  5.42 
     RV           L       2.80      8.00     285.2      1.00      5.00  U  3.68 
     RV/TLC       %                  160 
  
  
               UNITS     PRED      ACTUAL     %PRED    PREV1     PREV2   CI 
FLOWS........................................................................... 
  
MACHINE: FLOW TURBINE 
  
    STANDARD STUDY                                     6/6/02    5/30/02 
    (NOTES): TEST STANDARD 
     FVC       L          7.76      4.30      55.4      8.00      9.00 
     FEV1      L          5.79      2.20      38.0      6.00      4.00    4.94 
     PF        L/SEC     10.986     3.200     29.1      5.000     5.000   8.02 
     FEF25-75  L/SEC      4.478     4.500    100.5      4.000    15.000   2.81 
     MVV       L/MIN     211.72     3.00       1.4      4.00     10.00  163.87 
     FEV1/FVC    %                    51 
  
    AFTER INHALATION CHALLENGE                         6/6/02    5/31/02 
    (NOTES): AFTER INHALATION 
     FVC       L          7.76      7.00      90.2      8.00      9.00 
     FEV1      L          5.79      4.00      69.1      7.00      8.00    4.94 
     PF        L/SEC     10.986     3.000     27.3      6.000     7.000   8.02 
     FEF25-75  L/SEC      4.478     5.000    111.6      5.000    10.000   2.81 
     MVV       L/MIN     211.72     3.00       1.4      4.00     50.00  163.87 
     FEV1/FVC    %                    57 
  
    AFTER EXERCISE                                     6/6/02    5/31/02 
     FVC       L          7.76      5.00      64.4      8.00      9.90 
     FEV1      L          5.79      3.00      51.9      7.00      8.00    4.94 
     PF        L/SEC     10.986     2.000     18.2      6.000     7.000   8.02 
     FEV1/FVC    %                    60 
  
DIFFUSION....................................................................... 
  METHOD: STEADY STATE 
                                                       6/30/03   6/6/02 
     DLCO-SB   L         37.16     33.00      88.8     45.00     50.00   29.18 
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Corr DLCO for HB & COHB: 37.16     32.55      87.6 
  
  
BLOOD GASES..................................................................... 
  
  
STUDY TYPE      pH    pCO2  pO2     O2HB   COHB MHB    HB   FiO2 A-aO2  QS/QT 
  (NORMAL)  7.36-7.44 36-44 80-100 >88%    <3%  <2%              <22 
100% O2 STUDY  7.000   0.0   0.0    4.0%   0.0% 0.0%   3.0 0.500  277  
PATIENT TEMPERATURE (C): 35 
MAX EXERCISE   8.000  44.0   3.0   53.0%  33.0%23.0%  15.4 0.343  132  
PATIENT TEMPERATURE (C): 30 
(NOTES): TEST QS 
SUPPLEMENTAL   8.000   9.0   0.0   67.0%   0.0%56.0%   0.0 0.900  486  
PATIENT TEMPERATURE (C): 32 
POST EXERCISE  7.456  99.0 345.0   78.0%  45.0%45.0%  15.1 1.000   84   0.52 
PATIENT TEMPERATURE (C): 33 
(NOTES): TEST QS 
  
  
  
  
               UNITS               ACTUAL              PREV1     PREV2 
SPECIAL STUDIES................................................................. 
  
     MAXIMUM PRESSURES                                 6/30/03   6/6/02 
    (NOTES): 44 
     PiMAX        cmH2O             5.00               99.00     68.00 
  
     MECHANICS                                         6/30/03   6/6/02 
     Raw          cmH20/L/S         4.00               15.00     10.00 
     SGaw         L/S/cmH20         0.30                0.30      0.20 
     Cst          4cmH20            0.50                1.00      0.40 
  
     SMALL AIRWAY                                      6/30/03   6/6/02 
     Cdyn         L/cmH20           0.40                1.00      0.45 
     FEF50 He-Air L/Sec            45.00               45.00     56.00 
     VISOV        L                 3.00                5.00      5.00 
     CV           L                 5.00                4.00      5.00 
     CV/VC        %                 2.50      
     CV/TLC       %                 1.67 
     VISOV/CV     %                 0.60 
  
     EXERCISE                                          6/30/03   6/6/02 
    (NOTES): Insert note here 
     VEmax(BTPS)  L                44.00               90.00     90.00 
     BR           L                34.00               50.00     50.00 
     VD/VT MAX    L                 0.70                          0.43 
     VErest(BTPS) ml/beat           3.00               35.00     30.00 
     EKG                           ABNORMAL 
     Wmax         wrpm/min          2.00               100.00    245.00 
     WRI/WRT      watts/min         3.00               35.00     40.00 
     Max Speed    mph              15.00               20.00     15.00 
     TOTAL TIME   min              100.00              100.00    600.00 
Exercise Testing Mode: BIKE ERGOMETER 
REASON(S) FOR STOPPING: 
                           Patient cannot work on Bike Treadmill anymore.  
                           he will work on something different such as a 
                           Cardioglider. 
  
INTERPRETATION: 
  
COMMENTS AND RECOMMENDATIONS: 
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INTERPRETED BY:  
                CPUSER, TEN 
  
  
  
                        PREDICTED VALUE FORMULAS USED 
    TLC              .078*HT-7.3                  BOREN & KORY '66 
    VC               .06*HT-(.0214*AGE)-4.65      CRAPO '81 
    FRC              .032*HT-2.94                 BOREN & KOREY '66 
    RV               .019*HT+(.0115*AGE)-2.24     BOREN & KORY '66 
    FVC              .06*HT-(.0214*AGE)-4.65      CRAPO '81 
    FEV1             .0414*HT-(.0244*AGE)-2.190   CRAPO '81 
    PF               3.9*HT-(3*AGE)-49.36/60      FERRIS '64 
    FEF25-75         .0204*HT-(.038*AGE)+2.133    CRAPO '81 
    MVV              1.356*HT-(1.26*AGE)-21.4     BOREN & KOREY '66 
    DLCO-SB          12.9113-(.229*AGE)+(.1672*HT) MILLER '83 
    COHB CORR.       ACT*(1+(COHB/100))           MORRIS '85 
    HB CORR.         HB+10.22/(1.7*HB)*ACT        COTES '72 
NOTE:  HT=height,WT=weight,ACT=actual measurement value 
*** END ***************  CONFIDENTIAL  SUMMARY   pg. 1 *********************** 
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Procedures (local only) 
 
This report component lists all Medicine and CP procedures for a selected patient in CPRS. The 
Procedures (local only) list contains the following column elements: Procedure Date/Time, 
Medicine Procedure Name, and Report Status (also known as the Procedure Summary Code).  
 

 
 
The Procedure Date/Time column lists the procedures in chronological order. Both the Medicine 
and CP procedures are listed together. After you select the procedure that you want to view, the 
report is displayed in the lower-right portion of your screen. If you see an interpretation (TIU 
document), then you are viewing a CP procedure, otherwise you are viewing a Medicine 
procedure. 
 
Here is an example of a CP Report. 
 
 
Pg. 1                         HINES VAMC 
                         SPIROMETRY, PRE and POST 
CPPATIENT1, TEN    000-00-0110                     DOB: FEB 3,1943  (61) 3AS  
------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
 
       TITLE: HISTORICAL PROCEDURE REPORT                               
DATE OF NOTE: JUL 03, 2003@13:46     ENTRY DATE: JUL 03, 2003@13:46:22       
      AUTHOR: CPUSER1, ONE           EXP COSIGNER:                            
     URGENCY:                            STATUS: COMPLETED                      
 
PROCEDURE SUMMARY CODE: Abnormal                       
DATE/TIME PERFORMED: JUL 03, 2003@13:45   
 
TEST 
 
/es/ CPUSER1, ONE                                                    
MEDICAL SPECIALIST                                                         
Signed: 03/12/2004 11:04                                                   
-------------------------------------------------------------------------------- 
 
       TITLE: PFT                                                       
DATE OF NOTE: JUL 03, 2003@13:53     ENTRY DATE: JUL 03, 2003@13:53          
      AUTHOR:                      EXP COSIGNER:                            
     URGENCY:                            STATUS: UNDICTATED                     
 
PROCEDURE SUMMARY CODE:                                
DATE/TIME PERFORMED: JUL 03, 2003@13:45   
 
-------------------------------------------------------------------------------- 
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       TITLE: PFT                                                       
DATE OF NOTE: JUL 03, 2003@14:34:32  ENTRY DATE: JUL 03, 2003@14:34:32       
      AUTHOR:                      EXP COSIGNER:                            
     URGENCY:                            STATUS: UNDICTATED                     
 
PROCEDURE SUMMARY CODE:                                
DATE/TIME PERFORMED: JUL 03, 2003@13:45   
 
================================================================================ 
 
NOTE: Images are associated with this procedure. 
      Please use Imaging Display to view the images. 
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Here is an example of a Medicine Report. 
 
Pg. 1                         HINES VAMC               05/03/04 13:30 
            ELECTROPHYSIOLOGY REPORT - RELEASED ON-LINE VERIFIED               
CPPATIENT1, TEN    000-00-0110                     DOB: FEB 3,1943  (61) 3AS  
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -  
DATE/TIME:   6/30/03@10:40 
MEDICAL PATIENT:   CPPATIENT1, TEN 
WARD/CLINIC:   CARDIAC CLINIC 
CARDIAC DX:   AORTIC STENOSIS 
REASON FOR STUDY:   AGINA PROBLEMS. 
  
SYMPTOM:  
  UNSTABLE ANGINA 
  
RISK FACTOR:  
  CARDIOMEGALY (X-RAY) 
  
ARRHYTHMIA DX:  
  HEART BLOCK-MOBITZ II 
  
HX:  
  This is the HX text. 
  
 - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 
                  R e p o r t   R e l e a s e   S t a t u s 
  
Current            Date     Person Who 
Report             Status   Last Changed             Date of            Report 
Status             Changed  The Status                Entry             Version 
=============================================================================== 
RELEASED ON-LINE VERIFIED 
                   6/30/03  NA JACKSONS            6/30/03            1 of 1 
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Procedures 
 
This report component lists Medicine and CP procedures for a selected patient visiting your 
facility, who is typically seen at another facility. You can view a patient’s data from a remote 
facility, which is called remote data viewing.   
 

 
 
The procedures are listed in chronological order within a specified date range and a maximum 
number of occurrences (Max/site). The name of the report, selected date range and maximum 
number of occurrences (Max/site) appear above the procedure list.   
 
Procedure Date/Time 
  09/02/2003 16:30 
Medicine Procedure Name      
  ECHO 
Summary 
  No Summary 
Detailed Report 
                     :     
                         ------------------------------------------------------------- 
                           
                                TITLE: ECHO EXAM                                   
                                      DATE OF NOTE: MAR 05, 2002@08:53     ENTRY 
                         DATE: MAR 05, 2002@08:53:14       
                               AUTHOR: CPUSER1, ONE        EXP COSIGNER:          
                                           
                              URGENCY:                            STATUS: 
                         COMPLETED                      
                           
                         PROCEDURE SUMMARY CODE: Abnormal                       
                         DATE/TIME PERFORMED: MAR 04, 2002@12:21   
                           
                         test  
                           
                         /es/ CPUSER1, TWO                                       
                                         MEDICAL SPECIALIST                        
                                                         Signed: 03/05/2002 12:06  
                                                                          
                         ------------------------------------------------------------- 
                           
                                TITLE: ECHO EXAM                                   
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                                      DATE OF NOTE: SEP 02, 2003@15:48:49  ENTRY 
                         DATE: SEP 02, 2003@15:48:49       
                               AUTHOR:                      EXP COSIGNER:          
                                           
                              URGENCY:                            STATUS: 
                         UNDICTATED                     
                           
                         PROCEDURE SUMMARY CODE:                                
                         DATE/TIME PERFORMED: SEP 02, 2003@16:30   
                           
                         
================================================================================ 
                           
                          
   
Facility: SUPPORT ISC 
=============================================================================== 
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Configuring the Medicine Report to Display in CPRS 
 
1The Medicine View file (#690.2) controls which fields are displayed in the Medicine reports 
except for the Procedures (local only) report. You can add and delete fields in the procedure type 
view template, which is located in the Medicine View file. When you edit the template, the 
Medicine reports within the Procedures (local only), Medicine/CP tree listing and the Health 
Summary reports are affected. 
 

If the report does not display, be sure the procedure that you want to display is entered in the 
PROCEDURE field for the appropriate template. 
 

You can use FileMan to add fields to the Medicine View file. The following are examples of 
adding a multiple field and a single field to a print template. 
 

 Here is an example of how to add field #37.1, which is a sub-file (multiple field) to the 
Full GI Medicine View entry. 

 
VA FileMan 22.0 
 
 
Select OPTION: 1  ENTER OR EDIT FILE ENTRIES 
 
 
INPUT TO WHAT FILE: HEALTH SUMMARY COMPONENT// 690.2  MEDICINE VIEW 
                                          (36 entries) 
EDIT WHICH FIELD: ALL// <RET> 
 
 
Select MEDICINE VIEW PRINT VIEW TEMPLATE NAME: Full GI       
ENDOSCOPY/CONSULT 
PRINT VIEW TEMPLATE NAME: Full GI// <RET> 
PRIMARY FILE: ENDOSCOPY/CONSULT// <RET> 
Select FIELD NUMBER: 203// <RET> 
  FIELD NUMBER: 203// <RET> 
  ORDER ENTRY USAGE: UNKNOWN// <RET> 
  ASTM: <RET> 
  VALUE TYPE: <RET> 
  UNITS: <RET> 
  RANGES: <RET> 
  SEG: <RET> 
  PIECE: <RET> 
  CODING METHOD: <RET> 
Select FIELD NUMBER: 37.1 
  Are you adding '37.1' as a new FIELD NUMBER (the 46TH for this MEDICINE 
VIEW)? No// y  (Yes) 
   FIELD NUMBER ASTM: <RET> 
  ORDER ENTRY USAGE: <RET> 
  ASTM: <RET> 
  VALUE TYPE: <RET> 
  UNITS: <RET> 
  RANGES: <RET> 
  SEG: <RET> 

                                                 
1 Patch MD*1.0*10  March 2005  Change dealing Medicine View file. 
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  PIECE: <RET> 
  CODING METHOD: <RET> 
Select FIELD NUMBER: <RET> 
Select SUB-FILE: 699.19// <RET> 
  SUB-FILE: 699.19// <RET> 
  Select SUB-FIELD: .01// <RET> 
    SUB-FIELD: .01// <RET> 
    ORDER ENTRY USAGE: <RET> 
    ASTM: <RET> 
    VALUE TYPE: <RET> 
    UNITS: <RET> 
    RANGES: <RET> 
    SEG: <RET> 
    PIECE: <RET> 
    CODING: <RET> 
  Select SUB-FIELD: <RET> 
Select SUB-FILE: 699.04 
  Are you adding '699.04' as a new SUB-FILE (the 23RD for this MEDICINE 
VIEW)? No// Y  (Yes) 
  Select SUB-FIELD: .01 
  Are you adding '.01' as a new SUB-FIELD (the 1ST for this SUB-FILE)? No// Y 
  (Yes) 
   SUB-FIELD ASTM: <RET> 
    ORDER ENTRY USAGE: <RET> 
    ASTM: <RET> 
    VALUE TYPE: <RET> 
    UNITS: <RET> 
    RANGES: <RET> 
    SEG: <RET> 
    PIECE: <RET> 
    CODING: <RET> 
  Select SUB-FIELD: <RET> 
Select SUB-FILE: <RET> 
Select PROCEDURE: GEN// ? 
    Answer with PROCEDURE 
   Choose from: 
   COL    
   EGD    
   ERC    
   GEN    
   GIENDO    
   LAP    
   LV PARAC    
   PARAC    
   VAS    
           
        You may enter a new PROCEDURE, if you wish 
    
 Answer with PROCEDURE/SUBSPECIALTY NAME, or GLOBAL LOCATION, or 
     TYPE OF PROCEDURE, or PRINT NAME 
 Do you want the entire 83-Entry PROCEDURE/SUBSPECIALTY List? N  (No) 
Select PROCEDURE: GEN// <RET> 
Type: Full// <RET> 
 
 
Select MEDICINE VIEW PRINT VIEW TEMPLATE NAME: <RET> 
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 Here is an example of how to add a single field #204.5 to the Full GI Medicine View file 
(#690.2). 

 
Select MEDICINE VIEW PRINT VIEW TEMPLATE NAME:    Full GI     
ENDOSCOPY/CONSULT 
PRINT VIEW TEMPLATE NAME: Full GI// <RET> 
PRIMARY FILE: ENDOSCOPY/CONSULT// <RET> 
Select FIELD NUMBER: 37.1// <RET> 
  FIELD NUMBER: 37.1// <RET> 
  ORDER ENTRY USAGE: <RET> 
  ASTM: <RET> 
  VALUE TYPE: <RET> 
  UNITS: <RET> 
  RANGES: <RET> 
  SEG: <RET> 
  PIECE: <RET> 
  CODING METHOD: <RET> 
Select FIELD NUMBER: 204.5 
  Are you adding '204.5' as a new FIELD NUMBER (the 47TH for this MEDICINE 
VIEW)? No// Y  (Yes) 
   FIELD NUMBER ASTM: <RET> 
  ORDER ENTRY USAGE: <RET> 
  ASTM: <RET> 
  VALUE TYPE: <RET> 
  UNITS: <RET> 
  RANGES: <RET> 
  SEG: <RET> 
  PIECE: <RET> 
  CODING METHOD: <RET> 
Select FIELD NUMBER: <RET> 
Select SUB-FILE: 699.04// <RET> 
  SUB-FILE: 699.04// <RET> 
  Select SUB-FIELD: .01// <RET> 
    SUB-FIELD: .01// <RET> 
    ORDER ENTRY USAGE: <RET> 
    ASTM: <RET> 
    VALUE TYPE: <RET> 
    UNITS: <RET> 
    RANGES: <RET> 
    SEG: <RET> 
    PIECE: <RET> 
    CODING: <RET> 
  Select SUB-FIELD: <RET> 
Select SUB-FILE: <RET> 
Select PROCEDURE: GEN// <RET> 
Type: Full// <RET> 
 
 
Select MEDICINE VIEW PRINT VIEW TEMPLATE NAME: <RET> 
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1Ad Hoc Health Summary Components for CP Reports 
 
A patient at a site can have multiple procedures performed.  Over a certain period of time, this 
would make it difficult for the physician to search through the Clinical Reports for Medicine/CP 
Reports in CPRS.  With patch MD*1*21, the site can setup an Ad Hoc Health Summary 
component for a specific procedure such as Electrocardiogram.  The component would be used 
to group the CP reports for that procedure.  This way, the physician can just look through the 
reports for a specific procedure.  If your site has certain procedures that are high volume, you can 
set this up.  Please contact your IRM programmer and Clinical Application Coordinator and have 
them refer to Step 3 – Create Ad Hoc Health Summary Component for CP of Chapter 10 - 
Setting Up CPRS for Clinical Procedures in the Clinical Procedures Implementation Guide for 
the setup. 
 
The next few screen captures depict an example Ad Hoc HS component that was created for the 
EKG reports: 
 
Select Reports tab in CPRS and select Ad Hoc Report within the Health Summary tree view. 
 

 

 Figure 5-1 

 
 

                                                 
1 Patch MD*1.0*21  June 2010 – Ad Hoc Health Summary Components For CP reports. 
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Once you click the Ad Hoc Report, an Ad Hoc Health Summary window opens as demonstrated 
below:  

 

 Figure 5-2 

 

Find the Health Summary component that you want and select it.  Enter the Occurrence Limit 
and Time Limit that you want.  The Occurrence Limit field is the number of reports that you 
want displayed and the Time Limit is the date range to find the report such as 1Y (1 year).  Once 
you clicked the “OK” button, you should generate only EKG reports found for that occurrence 
and time limit.  
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6. 1Report Options 
 
The option Print list of Procedure with incomplete workload [MD PROC W/INCOMPLETE 
WORKLOAD] prints a list of procedures that have incomplete workload information for a date 
range.  This date range used is the date/time performed of the CP Result Report.  The list is 
sorted alphabetically by the Facility Treating Specialty and then alphabetically by the procedure 
name.  Within the procedure, a list of records with the visit date/time, patient name (last four of 
the social security number), Consult request number, Text Integration Utility (TIU) note number, 
and the missing data (Diagnosis, Current Procedure Terminology (CPT), or Provider) is 
generated.  This list can be used to let the Clinical Application Coordinator (CAC) know which 
study does not have the workload data entered.  All missing data should be entered by the CAC 
for the incomplete procedures using the Patient Care Encounter (PCE) option PCE Encounter 
Data Entry – Supervisor [PXCE ENCOUNTER ENTRY SUPER]. 
 
The input information needed to run the option is the following: 
 

1. Start Date – the starting date of the date/time performed of the CP Result Report. 
2. End Date – the ending date of the date/time performed of the CP Result Report. 
3. Facility Treating Specialty – enter a facility treating specialty or “ALL” for all Facility 

Treating Specialties. 
4. List Printer – enter a printer device to print the list or “HOME” for on screen display. 

 
Following is an example of running the option. 
 
Select OPTION NAME:    MD PROC W/INCOMPLETE WORKLOAD     Print list of Procedure 
 with incomplete workload 
Print list of Procedure with incomplete workload 
 
Select Start Date: T-365  (APR 07, 2009) 
 
Select End Date: T  (APR 07, 2010) 
 
Select Facility Treating Specialty (or ALL): ALL 
 
Select LIST Printer: HOME// 0;80;9999  TELNET 
 
Apr 07, 2010 3:29:20 pm                                                  Page 1 
 
     P R O C E D U R E S   W I T H   I N C O M P L E T E   W O R K L O A D 
 
 
                                  CARDIOLOGY 
 
Visit D/T         Patient                         Consult #   TIU #  MISSING 
------------------------------------------------------------------------------ 
PROCEDURE: CARDIAC CATHETERIZATION 
 

 

                                                 
1  Patch MD*1.0*21 June 2010 Added Report Options chapter. 
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07/14/05@17:19    CPPATIENT,ONE   (0000)            2618      4281   Diagnosis 
                                                                     CPT 
                                                                     Provider 
 
07/15/05@09:56    CPPATIENT,TWO   (0001)            2620      4248   Diagnosis 
                                                                     CPT 
                                                                     Provider 
 
 
Apr 07, 2010 3:29:20 pm                                                  Page 2 
 
     P R O C E D U R E S   W I T H   I N C O M P L E T E   W O R K L O A D 
 
 
                                  CARDIOLOGY 
 
Visit D/T         Patient                         Consult #   TIU #  MISSING 
------------------------------------------------------------------------------ 
PROCEDURE: EKG, ROUTINE (12 LEADS) 
 
 
04/13/09@09:37    CPPATIENT,THREE (0002)            3757      5694   Diagnosis 
                                                                     CPT 
                                                                     Provider 
04/13/09@10:22    CPPATIENT,FOUR  (0003)            3758      5695   Diagnosis 
                                                                     CPT 
 
04/20/09@09:46    CPPATIENT,FIVE (0004)             3760      5698   Diagnosis 
                                                                     CPT 
 
04/20/09@10:25    CPPATIENT,SIX  (0005)             3761      5699   Diagnosis 
                                                                     CPT 
 
04/21/09@16:18    CPPATIENT,SEVEN (0006)            3762      5702   Diagnosis 
                                                                     CPT 
 

The Clinical Procedures Studies List [MD STUDIES LIST] option generates a report which lists 
all studies associated with the consult requests.  The report should be sent to a 132 column 
printer.  This list includes consult requests that are in an active, pending, partial result, or 
complete status.  Any consult request that has a complete status with a request date over a year 
ago will be screened out of the list.  The list is sorted by Facility Treating Specialty and then by 
the medical device name.  The report displays the following information: 
 

1. Patient – name of patient 
2. ID# - Patient last four numbers of the social security number. 
3. Consult # - consult request number 
4. Reqd. Date/Time – date/time of consult request 
5. Urgency – the consult urgency (routine, emergency, stat…etc) 
6. Procedure –CP Definition name 
7. CP Status – the status of the CP study (Pending, Complete, Ready) 

 
 
 
 
 
 
 

8. Check-In Date/Time – date/time of study check-in 
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The input information needed to run the option is the following: 
 

1. Facility Treating Specialty – enter a facility treating specialty or “ALL” for all facility 
treating specialties 

2. List printer – enter a 132 column printer for the report. 
 
Select OPTION NAME:    MD STUDIES LIST     Clinical Procedures Studies List 
Clinical Procedures Studies List 
 
Select Facility Treating Specialty (or ALL): GASTROENTEROLOGY       GASTROENTEROLOGY     GAS 
 
 
The report requires a 132 column printer. 
 
 
Select LIST Printer: HOME// 0;132;9999  TELNET 

 
The screen capture in the next page shows a sample run of the Clinical Procedures Studies List. 
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r 07, 2010 4:16:34 pm                    C L I N I C A L   P R O C E D U R E S   S T U D I E S   L I S T                 Page 1 
 
 
                                                         GASTROENTEROLOGY 
 
AXIOM Sensis (Bi-Directional) 
============================= 
 
 
 
                                               Reqd.                                                      CP     Check-In 
Patient                  ID#   Consult #     Date/Time             Urgency    Procedure                 Status   Date/Time 
---------------------------------------------------------------------------------------------------------------------------------
- 
 
CPPATIENT,EIGHT          0007  3317          1/9/07 11:12:37 am    Routine    COLONOSCOPY               Compl  1/9/07 11:18:14 am 
 
CPPATIENT,NINE           0008  3318          1/9/07 11:22:22 am    Routine    COLONOSCOPY               Compl  1/9/07 11:23:54 am 
 
CPPATIENT,TEN            0009  3317          1/9/07 11:12:37 am    Routine    COLONOSCOPY               Compl  1/9/07 11:24:43 am 
 
CPPATIENT,ONE            0010  3317          1/9/07 11:12:37 am    Routine    COLONOSCOPY               Compl  1/9/07 11:26:16 am 
 
CPPATIENT,TWO            0011  3318          1/9/07 11:22:22 am    Routine    COLONOSCOPY               Compl  1/9/07 11:28:45 am 
 
CPPATIENT,THREE          0012  2725          9/2/05 12:30:59 pm    Routine    COLONOSCOPY               Error  9/2/05 12:32:07 pm 
 
CPPATIENT,FOUR           0013   2767        9/20/05 10:05:21 am   Routine    COLONOSCOPY               Compl  9/20/05 10:05:51 am 
 
CPPATIENT,FIVE           0014  3642         10/29/08 2:17:56 pm   Routine    COLONOSCOPY               Compl  10/29/08 3:08:13 pm 
 
CPPATIENT,SIX            0015  3794         5/1/09 11:04:33 am    Routine    COLONOSCOPY               Ready  5/18/09 11:31:02 am 
 
CPPATIENT,SEVEN          0016  1039         9/20/01 9:36:47 am    Routine    COLONOSCOPY               Compl  9/21/01 11:53:01 am 
 
CPPATIENT,EIGHT          0017  1602          8/2/02 1:26:03 pm     Routine    COLONOSCOPY               Compl  8/2/02 1:41:48 pm 
 
CPPATIENT,NINE           0018  2412         4/25/05 8:12:16 am    Routine    COLONOSCOPY               Compl  5/19/05 11:11:28 am 
 
CPPATIENT,TEN            0019  687           3/14/01 8:10:34 am    Routine    COLONOSCOPY               Error  3/14/01 8:10:51 am 
 
CPPATIENT,ONE            0020  716          3/21/01 10:04:54 am   Routine    COLONOSCOPY               Compl  3/21/01 10:08:49 am 
  
CPPATIENT,TWO            0021  731           3/22/01 8:43:03 am    Routine    COLONOSCOPY               Compl  3/22/01 4:05:21 pm 
 
CPPATIENT,THREE          0022  1480          4/19/02 1:14:29 pm    Routine    COLONOSCOPY               Compl  4/19/02 1:17:11 pm 
 
CPPATIENT,FOUR           0023  1500          4/24/02 1:25:38 pm    Routine    COLONOSCOPY               Compl  5/7/02 1:18:31 pm 
 
CPPATIENT,FIVE           0024  2073         5/21/04 10:23:36 am   Routine    COLONOSCOPY               Ready  5/21/04 10:23:56 am 
 
CPPATIENT,SIX            0025  3457          9/25/07 9:35:45 am    Routine    COLONOSCOPY               Pendi  9/25/07 9:35:45 am 
 
CPPATIENT,SEVEN          0026  3454         9/24/07 11:35:44 am   Routine    COLONOSCOPY               Pendi  9/24/07 11:35:44 am 
 
CPPATIENT,EIGHT          0027  912           6/19/01 8:07:11 am    Routine    COLONOSCOPY               Compl  6/19/01 2:20:56 pm 
 
CPPATIENT, NINE          0028  912           6/19/01 8:07:11 am    Routine    COLONOSCOPY               Compl  6/19/01 2:22:06 pm 
 
CPPATIENT,TEN            0029  926           6/22/01 2:11:39 pm    Routine    COLONOSCOPY               Compl  6/22/01 2:20:50 pm 
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                                                         GASTROENTEROLOGY 
 
CTX (Bi-Directional) 
==================== 
 
                                               Reqd.                                                      CP     Check-In 
Patient                  ID#   Consult #     Date/Time             Urgency    Procedure                 Status   Date/Time 
---------------------------------------------------------------------------------------------------------------------------------
- 
 
CPPATIENT,EIGHT          0008  1602          8/2/02 1:26:03 pm     Routine    COLONOSCOPY               Error  8/2/02 1:55:54 pm 
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                                                         GASTROENTEROLOGY 
 
DMS (Bi-Directional) 
==================== 
 
                                               Reqd.                                                      CP     Check-In 
Patient                  ID#   Consult #     Date/Time             Urgency    Procedure                 Status   Date/Time 
---------------------------------------------------------------------------------------------------------------------------------
- 
 
CPPATIENT,ONE          0001  3866          6/24/09 9:10:57 am    Routine    COLONOSCOPY               Compl  6/24/09 9:14:38 am 
 
CPPATIENT,TWO          0002  1359          1/28/02 9:16:32 am    Routine    COLONOSCOPY               Pendi  7/1/09 2:33:46 pm 
 
CPPATIENT,THREE        0003  1870          8/19/03 1:03:29 pm    Routine    COLONOSCOPY               Pendi  7/1/09 2:34:02 pm 
 
CPPATIENT,FOUR         0004  3900          7/1/09 2:34:03 pm     Routine    COLONOSCOPY               Pendi  7/1/09 2:34:03 pm 
 
CPPATIENT,FIVE         0005  1240          12/3/01 3:09:21 pm    Routine    COLONOSCOPY               Pendi  7/1/09 2:33:56 pm 
 
CPPATIENT,SIX          0006  1347          1/16/02 1:37:51 pm    Routine    COLONOSCOPY               Pendi  7/1/09 2:33:48 pm 
 
CPPATIENT,SEVEN        0007  826           4/16/01 11:49:05 am   Routine    COLONOSCOPY               Pendi  7/1/09 2:33:42 pm 
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7. Glossary 
 
Access Code   A unique sequence of characters known by and assigned only to the user, the 

system manager and/or designated alternate(s). The access code (in conjunction with the 
verify code) is used by the computer to identify authorized users. 

 
Action   A functional process that a clinician or clerk uses in the TIU computer program. For 

example, “Edit” and “Search” are actions. Protocol is another name for Action. 
 
ADP Coordinator/ADPAC/Application Coordinator   Automated Data Processing Application 

Coordinator. The person responsible for implementing a set of computer programs 
(application package) developed to support a specific functional area such as clinical 
procedures, PIMS, etc. 

 
Application   A system of computer programs and files that have been specifically developed to 

meet the requirements of a user or group of users.  
 
Archive   The process of moving data to some other storage medium, usually a magnetic tape, 

and deleting the information from active storage in order to free-up disk space on the system. 
 
ASU   Authorization/Subscription Utility, an application that allows sites to associate users with 

user classes, allowing them to specify the level of authorization needed to sign or order 
specific document types and orderables. ASU is distributed with TIU in this version; 
eventually it will probably become independent, to be used by many VistA packages. 

 
Attachments   Attachments are files or images stored on a network share that can be linked to the 
CP study. CP is able to accept data/final result report files from automated instruments. The file 
types that can be used as attachments are the following: 
 

 .txt  Text files 
 .rtf Rich text files 
 .jpg JPEG Images 
 .jpeg JPEG Images 
 .bmp Bitmap Images 
 .tiff TIFF Graphics (group 3 and group 4 compressed and uncompressed types)  
 .pdf Portable Document Format 
 .html Hypertext Markup Language  
 
.DOC (Microsoft Word files) are not supported. Be sure to convert .doc files to .rtf or to 
.pdf format. 

 
Background Processing   Simultaneous running of a "job" on a computer while working on 

another job. Examples would be printing of a document while working on another, or the 
software might do automatic saves while you are working on something else. 
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Backup Procedures   The provisions made for the recovery of data files and program libraries 
and for restart or replacement of ADP equipment after the occurrence of a system failure. 

 
Boilerplate Text   A pre-defined TIU template that can be filled in for Titles, Speeding up the 

entry process. TIU exports several Titles with boilerplate text which can be modified to meet 
specific needs; sites can also create their own. 

 
Browse   Lookup the file folder for a file that you would like to select and attach to the study. 

(e.g., clicking the “...” button to start a lookup). 
 

Bulletin   A canned message that is automatically sent by MailMan to a user when something 
happens to the database. 

 
Business Rule   Part of ASU, Business Rules authorize specific users or groups of users to 

perform specified actions on documents in particular statuses (e.g., an unsigned TIU note 
may be edited by a provider who is also the expected signer of the note). 

 
Class   Part of Document Definitions, Classes group documents. For example, “CLINICAL 

PROCEDURES” is a class with many kinds of Clinical Procedures notes under it. Classes 
may be subdivided into other Classes or Document Classes. Besides grouping documents, 
Classes also store behavior which is then inherited by lower level entries. 

 
Consult   Referral of a patient by the primary care physician to another hospital service/ 

specialty, to obtain a medical opinion based on patient evaluation and completion of any 
procedures, modalities, or treatments the consulting specialist deems necessary to render a 
medical opinion. 

 
Contingency Plan   A plan that assigns responsibility and defines procedures for use of the 

backup/restart/recovery and emergency preparedness procedures selected for the computer 
system based on risk analysis for that system. 

 
CP   Clinical Procedures. 
 
CP Definition   CP Definitions are procedures within Clinical Procedures. 
 
1CP Procedure   A procedure who’s data is stored in the Clinical Procedures package. 
 
CP Study   A CP study is a process created to link the procedure result from the medical device 

or/and to link the attachments browsed from a network share to the procedure order. 
 
CPRS   Computerized Patient Record System. A comprehensive VistA program, which allows 

clinicians and others to enter and view orders, Progress Notes and Discharge Summaries 
(through a link with TIU), Problem List, view results, reports (including health summaries), 
etc. 

 
                                                 
1 Patch MD*1.0*2  July 2004  New Glossary term added. 
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Data Dictionary   A description of file structure and data elements within a file. 
 
Device   A hardware input/output component of a computer system (e.g., CRT, printer). 
 
Document Class   Document Classes are categories that group documents (Titles) with similar 

characteristics together. For example, Cardiology notes might be a Document Class, with 
Echo notes, ECG notes, etc. as Titles under it. Or maybe the Document Class would be 
Endoscopy Notes, with Colonoscopy notes, etc. under that Document Class. 

 
Document Definition   Document Definition is a subset of TIU that provides the building blocks 

for TIU, by organizing the elements of documents into a hierarchy structure. This structure 
allows documents (Titles) to inherit characteristics (such as signature requirements and print 
characteristics) of the higher levels, Class and Document Class. It also allows the creation 
and use of boilerplate text and embedded objects. 

 
Edit   Used to change/modify data typically stored in a file. 
 
Field   A data element in a file.  
 
File   The M construct in which data is stored for retrieval at a later time. A computer record of 

related information. 
 
File Manager or FileMan   Within this manual, FileManager or FileMan is a reference to VA 

FileMan. FileMan is a set of M routines used to enter, edit, print, and sort/search related data 
in a file, a database.   

 
File Server   A machine where shared software is stored. 
 
Gateway   The software that performs background processing for Clinical Procedures.  
 
Global   An M term used when referring to a file stored on a storage medium, usually a magnetic 

disk.  
 

GUI   Graphical User Interface - a Windows-like screen that uses pull-down menus, icons, 
pointer devices, and other metaphor-type elements that can make a computer program 
more understandable, easier to use, allow multi-processing (more than one window or 
process available at once), etc. 
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Interpreter   Interpreter is a user role exported with USR*1*19 to support the Clinical Procedures 
Class. The role of the Interpreter is to interpret the results of a clinical procedure. Users who 
are authorized to interpret the results of a clinical procedure are sent a notification when an 
instrument report and/or images for a CP request are available for interpretation. Business 
rules are used to determine what actions an interpreter can perform on a document of a 
specified class, but the interpreter themselves are defined by the Consults application. These 
individuals are ‘clinical update users’ for a given consult service.   

 
IRMS   Information Resource Management Service. 
 
Kernel   A set of software utilities. These utilities provide data processing support for the 

application packages developed within the VA. They are also tools used in configuring the 
local computer site to meet the particular needs of the hospital. The components of this 
operating system include: MenuMan, TaskMan, Device Handler, Log-on/Security, and other 
specialized routines. 

 
LAYGO   An acronym for Learn As You Go. A technique used by VA FileMan to acquire new 

information as it goes about its normal procedure. It permits a user to add new data to a file. 
 
M   Formerly known as MUMPS or the Massachusetts (General Hospital) Utility Multi-

Programming System. This is the programming language used to write all VistA 
applications. 

 
MailMan   An electronic mail, teleconferencing, and networking system. 
 
1Medicine Procedure   A procedure who’s data is stored in the Medicine package. 
 
Menu   A set of options or functions available to users for editing, formatting, generating reports, 

etc. 
 
Module   A component of a software application that covers a single topic or a small section of a 

broad topic. 
 
Namespace   A naming convention followed in the VA to identify various applications and to 

avoid duplication. It is used as a prefix for all routines and globals used by the application.  
 
Network Server Share   A machine that is located on the network where shared files are stored. 
 
Notebook   This term refers to a GUI screen containing several tabs or pages. 
 
OI   Office of Information, formerly known as Chief Information Office Field Office, 

Information Resource Management Field Office, and Information Systems Center. 
 

                                                 
1 Patch MD*1.0*2  July 2004  New Glossary term added. 
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Option   A functionality that is invoked by the user. The information defined in the option is used 
to drive the menu system. Options are created, associated with others on menus, or given 
entry/exit actions.  

 
Package   Otherwise known as an application. A set of M routines, files, documentation and 

installation procedures that support a specific function within VistA. 
 
Page   This term refers to a tab on a GUI screen or notebook. 
 
Password   A protected word or string of characters that identifies or authenticates a user, a 

specific resource, or an access type (synonymous with Verify Code). 
 
Pointer   A special data type of VA FileMan that takes its value from another file. This is a 

method of joining files together and avoiding duplication of information.   
 
Procedure Request   Any procedure (EKG, Stress Test, etc.) which may be ordered from another 

service/specialty without first requiring formal consultation. 
 
Program   A set of M commands and arguments, created, stored, and retrieved as a single unit in 

M. 
 
Queuing   The scheduling of a process/task to occur at a later time. Queuing is normally done if a 

task uses up a lot of computer resources. 
 
RAID  Redundant Array of Inexpensive Drives. Imaging uses this to store images. 
 
1Remote Data Viewing   The act of viewing a patient’s data from a remote facility. 
 
Result   A consequence of an order. Refers to evaluation or status results. When you use the 

Complete Request (CT) action on a consult or request, you are transferred to TIU to enter the 
results. 

 
<RET>   Carriage return. 
 
Routine   A set of M commands and arguments, created, stored, and retrieved as a single unit in 

M. 
 
Security Key   A function which unlocks specific options and makes them accessible to an 

authorized user. 
 
Sensitive Information   Any information which requires a degree of protection and which should 

be made available only to authorized users. 
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Site Configurable   A term used to refer to features in the system that can be modified to meet the 
needs of each site. 

 
Software   A generic term referring to a related set of computer programs. Generally, this refers 

to an operating system that enables user programs to run. 
 
Status Symbols   Codes used in order entry and Consults displays to designate the status of the 

order. 
 
Task Manager or TaskMan   A part of Kernel which allows programs or functions to begin at 

specified times or when devices become available. See Queuing. 
 
Title   Titles are definitions for documents. They store the behavior of the documents which use 

them. 
 
TIU   Text Integration Utilities. 
 
User   A person who enters and/or retrieves data in a system, usually utilizing a CRT. 
 
User Class   User Classes are the basic components of the User Class hierarchy of ASU 

(Authorization/Subscription Utility) which allows sites to designate who is authorized to do 
what to documents or other clinical entities. 

 
User Role   User Role identifies the role of the user with respect to the document in question 

(e.g., Author/Dictator, Expected Signer, Expected Cosigner, Attending Physician, etc.). 
 
Utility   An M program that assists in the development and/or maintenance of a computer 

system. 
 
Verify Code   A unique security code which serves as a second level of security access. Use of 

this code is site specific; sometimes used interchangeably with a password. 
 
VistA   Veterans Health Information Systems and Technology Architecture. 
 
Workstation   A personal computer running the Windows 9x or NT operating system. 
 



Index 

April 2004 Clinical Procedures V. 1.0 8-1 
 User Manual 

8. Index 
 

A 
Ad Hoc Health Summary Components for CP Reports, 5-

26 
Auto Check-In Without Appointment, 3-10 
Auto Study Check in, 3-9 
Auto Study Check-in With Appointment, 3-17 

B 
benefits, 1-6 
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study, 2-5 

E 
encounter information, 4-7 
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file types, 1-7 
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Configuring, 5-23 
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ordering 

consult procedures, 3-1 
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patient 
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ready to complete 
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Resulting High Volume Procedures, 4-14 

S 
sign off, 4-12 
status 

complete, 2-4 
error, 2-4 
types of, 2-3 

study 
checking in, 3-26 
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submitting, 3-29 
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entering interpretations, 4-1 
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